Thank you for purchasing this Panasonic product.

Before using this software, please read the instructions carefully.
## Contents

Precautions and Disclaimers ............................................................................................................ 4

What You Can Do with “Geometry Manager Pro” ............................................................... 5

Check Your Computer .................................................................................................................. 6

* System requirements ................................................................................................................. 6
* Necessary Environment for Computers to be Connected ......................................................... 6

Installing/Uninstalling Software ............................................................................................... 7

* Installation ................................................................................................................................. 7
  * Installing “Geometric & Setup Management Software” (Geometry Manager Pro) ......................... 7
  * Installing the “Auto Screen Adjustment plug-in software” ....................................................... 8
* Software Uninstall .................................................................................................................... 9

Preparation .................................................................................................................................. 10

Activation .................................................................................................................................... 12

* Perform the projector activation ............................................................................................... 12
* Perform the computer activation .............................................................................................. 15
* Functions which are expanded as a result of activation ............................................................ 20

Starting and Exiting the Application ....................................................................................... 21

* Starting the application ........................................................................................................... 21
* Exiting the application ............................................................................................................ 23

Adjustment and Settings ............................................................................................................ 24

* Main screen .............................................................................................................................. 24
  * Adjustment area ..................................................................................................................... 24
  * Main menu ............................................................................................................................ 25
  * Icon menu ............................................................................................................................ 29
  * Common operation area ......................................................................................................... 30
  * AUTO ADJUST (Auto Screen Adjustment) button ............................................................... 36
  * Status bar .............................................................................................................................. 36

* Lens Settings .......................................................................................................................... 37
  * Lens setting screen ............................................................................................................... 37

* Geometry Correction ............................................................................................................... 41
  * Geometry screen .................................................................................................................. 41
  * Selecting the control points ................................................................................................... 44
  * Free Grid (Free-form correction) .......................................................................................... 45
  * 4 Corner (4-corner correction) ............................................................................................. 45
  * Keystone (keystone shape correction) .................................................................................. 47
  * Cylindrical screen (cylindrical shape correction) ................................................................. 48
  * Elliptical screen (elliptical shape correction) ....................................................................... 50
  * Spherical screen (spherical correction) ............................................................................... 53
  * Rotation (rotation correction) .............................................................................................. 54
## Contents

**Edge Blending**  
- Edge Blending screen ........................................................................................................................................... 55  
- User-defined curve setting screen ...................................................................................................................... 58  

**Uniformity**  
- Uniformity screen ..................................................................................................................................................... 60  
- Flexible Correction Procedure .................................................................................................................................. 63  

**Brightness Control**  
- Brightness Control screen ................................................................................................................................………… 64  

**Color Matching**  
- Color Matching screen .................................................................................................................................................. 67  

**Masking**  
- Masking screen ............................................................................................................................................................. 69  
- Line Masking ................................................................................................................................................................. 72  
- Bitmap Masking .............................................................................................................................................................. 73  

**Input Signal Adjustments**  
- Input Signal screen ............................................................................................................................................................ 74  

**Projector Menu Settings**  
- Other screen .................................................................................................................................................................. 78  

**Projector Control**  
- Command Control screen ................................................................................................................................................ 86  
- Edit screen ........................................................................................................................................................................ 87  

**Auto Screen Adjustment**  
- Preparing Auto Screen Adjustment ............................................................................................................................ 88  
- Compatible screens for Auto Screen Adjustment ........................................................................................................ 89  
- Operation flow for Auto Screen Adjustment .................................................................................................................. 90  
- Auto Screen Adjustment procedure .................................................................................................................................. 91  
- Starting Auto Screen Adjustment and selecting the adjustment item ............................................................................... 91  
- Projector Layout ................................................................................................................................................................... 93  
- Camera Setting .................................................................................................................................................................... 96  
- Projection Setting ............................................................................................................................................................... 99  

**Frequently Asked Questions** ........................................................................................................................................... 113  

**Trademarks** .................................................................................................................................................................... 116
Precautions and Disclaimers

- Precautions regarding security
  When using the “Geometric & Setup Management Software” (Geometry Manager Pro), security breaches of the type described below are conceivable.
  - Leakage of your private information via this software
  - Illegal operation of this software by a malicious third-party
  - Harm to or cessation of operation of this software by a malicious third-party

Be sure to implement sufficient security measures.
  - Make sure the password is as hard to guess as possible.
  - Change the password periodically.
  - Panasonic Corporation and its affiliated companies never directly ask customers for their password. Do not give out your password even if directly asked by a third-party representing themselves as Panasonic Corporation.
  - Always use on a network that has safety protection such as a firewall implemented.
  - Set the password for the computer you are using in order to set limits on user accessibility.

- This software makes use of the following software.
  A portion of this software is based in part on the work of the Independent JPEG Group.

- The illustrations and display examples used in this manual may differ from the actual product.

- Panasonic cannot be held liable for damages arising from data corruption or loss as a result of using this projector.
What You Can Do with “Geometry Manager Pro”

Using this software allows you to perform real-time geometric compensation and other fine adjustments and corrections that cannot be handled on the projector side.

Even when you use this software, however, some functions and expanded functions may be limited if projector and computer activation are not completed.

☞ “Activation” (page 12)
☞ “Functions which are expanded as a result of activation” (page 20)

■ Geometry correction

When projecting images onto a screen surface that is not perfectly flat (such as the wall of a building) or projecting them onto a screen surface at an angle, the images become distorted.

When projecting images in these kinds of special environments, the geometry correction function serves to correct the images to counter the shape of the screen surface.

■ Edge blending

This function serves to correct the brightness and makes the joins between the images less visible when the images projected from a multiple number of projectors are combined to form a single image.

■ Uniformity

This function makes it possible to correct color irregularities in projected images – for example, those resulting from irregularities in the screen surface or from surrounding light and shade.

■ Masking

This function makes it possible to mask certain parts of the projected images, projecting only the required parts.

■ Auto Screen Adjustment (AUTO ADJUST)

This allows simple automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape of the screen through use of a camera.

Note

- Both “Geometry Manager Pro” and the “Geometry Manager Pro - Auto Screen Adjustment plug-in software” must be installed to use the Auto Screen Adjustment function.
- To use the Auto Screen Adjustment function, prepare a camera separately. ☞ “Camera connection” (page 88)

■ Other functions

The lens, color matching and input signal can all be adjusted.

Some of the projector’s menu operations can also be carried out on a computer screen.
Check Your Computer

System requirements

The computer must meet the following requirements in order to use the supplied software.

OS: Microsoft Windows 7 Ultimate 32/64bit, Professional 32/64bit

- Windows 8.1 32/64bit, Windows 8.1 Pro 32/64bit
- Windows 10 32/64bit, Windows 10 Pro 32/64bit

Compatible with English, Japanese or Chinese language versions of the above operating systems.

- Compatible with Windows 7 up to SP1.
- For a 64bit OS, this application runs on WOW64.

CPU: Clock speed of 1 GHz or higher

Memory: 2 GB or more

Available disk space:

- 16 GB or greater (Further available space is necessary to save projector information)

Other requirements:

- A display with a resolution of 1 024 × 768 pixel or higher using High Color (16 bit) or higher
- LAN port for a wired LAN (10Base-T/100Base-TX / 1000Base-T)
- USB2.0-compatible port or higher (when using the Auto Screen Adjustment function)

Note

- Please understand that operation is not guaranteed if this software application is used in a system environment other than that specified above or on a home-built computer.

Proper operation cannot be guaranteed for all computers even if they satisfy the above requirements.

Necessary Environment for Computers to be Connected

Be sure to check the following settings when connecting projectors to the computer via a wired LAN connection.

Computer with a built-in LAN function

- Is your LAN switched on?

Computer without a built-in LAN function

- Is your LAN adapter properly recognized?
  - Please install the LAN adapter driver beforehand.
  - For details on how to install the driver, please refer to instructions accompanying the LAN adapter.
- Is your LAN adapter switched on?

Note

- It may not be possible to establish a connection with the projector if security (firewall) software or utility software for LAN adapter are installed.

  “Frequently Asked Questions” (page 113)

- Operation is not guaranteed for all LAN adapters and built-in LAN adapters in the computers.
- An Internet connection is required to perform activation.
Installing/Uninstalling Software

Installation

Quit any applications running in Windows before starting installation. Failure to do so may result in improper installation.

Installing “Geometric & Setup Management Software” (Geometry Manager Pro)

1 Download the software.
   - Download “Geometry Manager Pro”.
     Log in to PASS*1 on the Panasonic website (https://panasonic.net/cns/projector/pass/), click [Software Download], and follow the on-screen instructions to download the software. You must be registered with PASS to log in to it.
     
     *1 PASS: Panasonic Professional Display and Projector Technical Support Website. For details on PASS, refer to the Panasonic website (https://panasonic.net/cns/projector/pass/).

     **Note**
     To enable use of the Auto Screen Adjustment function, download the “Auto Screen Adjustment plug-in software” as well.

     *“Installing the “Auto Screen Adjustment plug-in software”” (page 8)

2 The installer starts up.
   Double-click the downloaded “Installer.exe” file.

   ![Installer Start](image)

   Follow the on-screen instructions to install the application.

3 As soon as the installation process is completed, a shortcut icon is created on the desktop.

   ![Shortcut Icon](image)

   **Note**
   If an identical version of the software is already installed, the following screen for selecting whether to repair or remove the existing version appears.
Installing/Uninstalling Software

Installation

To repair defects in the software, select “Repair Geometry Manager Pro”, and click [Finish].
To uninstall the existing version before installing the software again, select [Remove Geometry Manager Pro], and click [Finish].
If you selected [Repair Geometry Manager Pro] and the “Insert disk” message is displayed, uninstall the application, and then reinstall it.

Installing the “Auto Screen Adjustment plug-in software”

1 Download the “Auto Screen Adjustment plug-in software”.
   Both “Geometry Manager Pro” and the “Geometry Manager Pro - Auto Screen Adjustment plug-in software” are necessary to use the Auto Screen Adjustment function.
   Log in to PASS on the Panasonic website (https://panasonic.net/cns/projector/pass/), click [Software Download], and follow the on-screen instructions to download the “Auto Screen Adjustment plug-in software”.

2 The installer starts up.
   Double-click the downloaded “AusInstaller.exe” file, and follow the on-screen instructions to install the application.
   **Note**
   The compatible combination of versions for the “Auto Screen Adjustment plug-in software” and the “Geometry Manager Pro” is predetermined. Therefore, an error message will appear if you attempt to install an incompatible version of the “Auto Screen Adjustment plug-in software”. In such cases, check whether the version of “Geometry Manager Pro” that appears in the error message matches the software version found on the above website. If the versions match, download and install only “Geometry Manager Pro” from the website. If the versions do not match, download and install both “Geometry Manager Pro” and the “Auto Screen Adjustment plug-in software”.

3 When installation is complete, the [AUTO ADJUST] (Auto Screen Adjustment) button at the top right of the “Geometry Manager Pro” main screen will be enabled.
   **Note**
   If you click the [AUTO ADJUST] button while the “Auto Screen Adjustment plug-in software” is not installed, a message indicating that installation of the plug-in software is required will appear.
Software Uninstall

Windows 7
Select [Geometry Manager Pro] from [Start] → [Control Panel] → [Uninstall a program], and click [Uninstall].

Windows 8.1 / Windows 10
Press [X] while holding down the [Windows logo] key on the keyboard. Select [Geometry Manager Pro] from [Control Panel] → [Uninstall a program], and click [Uninstall].

Note
Uninstalling “Geometry Manager Pro” will not uninstall the “Auto Screen Adjustment plug-in software”. Perform the same procedure as the above to uninstall the “Auto Screen Adjustment plug-in software” (Geometry Manager Pro - Auto Screen Adjustment plug-in).
Preparation

■ Projectors supported
For details on models compatible with “Geometry Manager Pro”, check the information found on the software download page after logging in to PASS on the Panasonic website (https://panasonic.net/cns/projector/pass/).

Note
No guarantees are made for the operations when the computer is connected to a non-supported projector.

■ Projector and computer connections
Connect the projector and computer using a LAN cable. Up to 99 projectors can be connected.

Note
- Please use a crossing cable to connect the computer and projector when it is directly connected to the LAN.
- When using a hub to connect, whether or not a straight cable or crossing cable or both can be used depends on the system configuration. Please consult your network administrator for details.

■ Setting the Computer

Network Setup
- Set the IP ADDRESS, SUBNET MASK and DEFAULT GATEWAY according to the operating environment. (Please consult your network administrator for details.)
- If “use of automatic script” is checked for your web browser, please uncheck.
- If “Use of Proxy server in LAN” is checked for your web browser, please uncheck, or set the projector IP address to “Exceptions” in the detailed proxy settings.
Preparation

■ Setting the Projector

Network Setup
Set the IP address, subnet mask, and default gateway according to your operating environment. (Please consult your network administrator for details.)
Set DHCP to OFF and set a fixed IP address, making sure that the entered IP address is not used by any other device on the LAN.
If the entered IP address is used by another device, the projector cannot be registered.

- For models that can be set, enable both WEB Control and Command Control.
- For models in which the Web port number can be set, set the port number to “80”.

Note
- Refer to operating manual of the projector for method on configuring the projector.
- This software identifies the projector using the configured IP address. If DHCP is set to ON in the projector network setting in a network environment that uses a DHCP server etc. the DHCP server may change the IP address allocated to the projector, making it impossible to connect using this software.
Please ensure the server does not change the IP address by, for example, setting the DHCP server so as to fix the IP address allocated to the projector. (Please consult your network administrator for details.)

■ Activation

There are functions that are enabled and functions that are expanded by performing activation.
The upgrade kit (ET-UK20), Auto Screen Adjustment upgrade kit (ET-CUK10), and Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P) are required for activation. For details on compatible projector models, check the information found on the activation page by logging in to PASS on the Panasonic website (https://panasonic.net/cns/projector/pass/).
☞ “Functions which are expanded as a result of activation” (page 20)

Note
The “Auto Screen Adjustment plug-in software” must be installed and the Auto Screen Adjustment upgrade kit (ET-CUK10) must be applied on the projector or the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P) must be applied on the computer to enable the Auto Screen Adjustment function.

■ Camera connection

To use the Auto Screen Adjustment function, prepare a camera separately.
For details on supported cameras and lenses and how to connect the camera to the computer, refer to “Auto Screen Adjustment” (page 88).
Activation

There are functions that are enabled and functions that are expanded by performing activation. There are two methods of activation: one is to apply a kit on the projector to add or expand the functions of the projector (projector activation) and the other is to apply a kit on the computer to expand the functions of the software installed on that computer (computer activation).

The upgrade kit (ET-UK20) and Auto Screen Adjustment upgrade kit (ET-CUK10) are required for the former method and the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P) is required for the latter method. For details on compatible projector models, check the information found on the activation page by logging in to PASS on the Panasonic website (https://panasonic.net/cns/projector/pass/).

*“Functions which are expanded as a result of activation” (page 20)

**Note**

Both “Geometry Manager Pro” and the “Auto Screen Adjustment plug-in software” must be installed to use the Auto Screen Adjustment function.

**Perform the projector activation**

The flow of operations from installation to activation is as follows. This sections describes projector activation.

1. **Have the key code ready.**
   
The key code is indicated on the key code label of the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit (ET-CUK10).
**Activation**

Perform the projector activation

2 **Start the software application, and display the main screen.**

 années “Adjustment and Settings – Main screen” (page 24)

3 **On the [File] menu, select [Activation] - [Export Equipment Profile] - [ET-UK20/ET-CUK10].**
   - All the projectors to which the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit (ET-CUK10) is not applied will be targets for operation.
   - All connected projectors will be displayed in the common operation area. However, the operation cannot be performed while two or more of these projectors are selected.
   - In the common operation area, an asterisk (*) appears to the left of projector names for which the upgrade kit (ET-UK20) has not been applied. You can check whether the Auto Screen Adjustment upgrade kit (ET-CUK10) is applied when using the Auto Screen Adjustment function.

   ![Image of Geometry Manager Pro interface]

   The file save screen is displayed.

4 **Specify the save destination, name the file, and save.**
   - The default file name is “SERIAL.LST.”

   When the confirmation screen for saving the file appears, click [OK].

5 **Start the web browser, and log in to PASS of the Panasonic website (https://panasonic.net/cns/projector/pass/).**

6 **Click the activation button in the side menu of the top page, and follow the on-screen instructions to perform key code registration, etc.**

   Register the key code readied in step 1 and the file (default file name: SERIAL.LST) saved in step 4 to PASS to acquire the activation code file (default file name: ACTIVE.LST).
   - The activation codes for the upgrade kit (ET-UK20) and the Auto Screen Adjustment upgrade kit (ET-CUK10) must be acquired separately.

7 **Close the web browser.**

The file selection screen is displayed.

Select the activation code file (default file name: ACTIVE.LST) acquired in step 6. When activation is complete and the confirmation screen appears, click [OK].
Perform the computer activation

This section describes computer activation.

1 Have the key code ready.
   The key code is indicated on the key code label of the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P).

2 Start the software application, and display the Connection Setting screen or the main screen.


   ![Software Interface]

   The [Input Key Code] screen appears.

4 In the [Input Key Code] screen, enter the key code indicated on the key code label.
   The key code consists of 25 single-byte alphanumeric characters. All letters should be uppercase, and 5 characters should be entered in each box.

   ![Key Code Input Screen]

   Click [OK] to display the file save screen.
5 Save the Volume Serial file (“SERIAL.LST”) to any location.

You can change the file name as desired, but do not change the extension (.LST). To return to the [Input Key Code] screen, click [Cancel] in the file save screen. When saving of the file is completed, the [Input Key Code] screen closes. Once the file has been saved, the volume serial number (20 single-byte alphanumeric characters) appears in the [Input Key Code] screen.

If you will enter this volume serial number manually to download an activation code file later in this procedure, write down this code and take care not to lose it before activation is completed.

6 Start the web browser, log in to PASS on the Panasonic website (https://panasonic.net/cns/projector/pass/), and click the [Activation] button from the side menu of the member top page.

7 Follow the on-screen instructions to download the activation code file.

Download the activation code file (“ACTIVE.LST”) using one of the following two methods.
When using a volume serial file (default file name: SERIAL.LST)
Follow the on-screen instructions to upload the volume serial file to PASS, enter the key code, and download the activation code file ("ACTIVE.LST") to any location.
- You can change the activation code file name as desired, but do not change the extension (.LST).
- The activation code (30 single-byte alphanumeric characters) is displayed after the activation code file is downloaded, but it is not used when using the activation code file ("ACTIVE.LST") to perform activation later in this procedure. If you will enter the activation code manually to perform activation, write down this code and take care not to lose it before activation is completed.

When entering the volume serial number manually
Follow the on-screen instructions to register the volume serial number to PASS, enter the key code, and download the activation code file ("ACTIVE.LST") to any location.
- The volume serial number consists of 20 single-byte alphanumeric characters. All letters should be uppercase, and 5 characters should be entered in each box.
- You can change the activation code file name as desired, but do not change the extension (.LST).
- The activation code (30 single-byte alphanumeric characters) is displayed after the activation code file is downloaded, but it is not used when using the activation code file to perform activation later in this procedure. If you will enter the activation code manually to perform activation, write down this code and take care not to lose it before activation is completed.

8 Close the web browser.

9 Perform activation.

Perform activation using one of the following two methods.

When using the activation code file (default file name: ACTIVE.LST)
2) Select the activation code file (default file name: ACTIVE.LST) downloaded from PASS.

When entering the activation code manually
2) After downloading the activation code file, enter the last 13 characters of the displayed activation code.
   - The activation code consists of 30 single-byte alphanumeric characters. All letters should be uppercase, and 3 characters should be entered in the first box and 5 characters should be entered in each of the remaining boxes for the last 13 characters.

10 When activation is completed, the activation code is registered to the computer.
When the confirmation screen appears, click [OK].

**Note**
- If activation failed, check the following again.
  - The key code input in the [Input Key Code] screen in step 4 and the key code input when uploading the volume serial file (default file name: SERIAL.LST) to PASS or registering the volume serial number to PASS are different.
  - The volume serial file or the volume serial number created in step 5 and the volume serial file uploaded to PASS when generating the activation code or the volume serial number entered when registering to PASS are different.
- When computer activation is completed, the [AUTO ADJUST] button at the top right of the main screen changes as shown below.
Functions which are expanded as a result of activation

Listed below are the functions which are expanded when the activation process has been completed.

### Upgrade kit (ET-UK20)

<table>
<thead>
<tr>
<th>Function</th>
<th>Activation not completed</th>
<th>Activation completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid pattern</td>
<td>When the resolution of the projector is 1920 x 1200 dots or 3840 x 2400 dots</td>
<td>2×2 to 11×11</td>
</tr>
<tr>
<td>Geometry Correction</td>
<td>Vertical keystone correction</td>
<td>±40°</td>
</tr>
<tr>
<td></td>
<td>Horizontal keystone correction</td>
<td>±15°</td>
</tr>
<tr>
<td></td>
<td>Vertical arcs</td>
<td>±50</td>
</tr>
<tr>
<td></td>
<td>Horizontal arcs</td>
<td>±50</td>
</tr>
<tr>
<td></td>
<td>Pincushion</td>
<td>±50</td>
</tr>
<tr>
<td>Rotational correction</td>
<td>–</td>
<td>√</td>
</tr>
<tr>
<td>Flip Vertical</td>
<td>–</td>
<td>√</td>
</tr>
<tr>
<td>Flip Horizontal</td>
<td>–</td>
<td>√</td>
</tr>
<tr>
<td>Uniformity</td>
<td>Flexible Correction</td>
<td>–</td>
</tr>
<tr>
<td>Masking</td>
<td>–</td>
<td>√</td>
</tr>
</tbody>
</table>

√: Can be used.
–: Cannot be used.

### Auto Screen Adjustment upgrade kit (ET-CUK10) / Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P)

This allows simple automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape of the screen through use of a camera.

**Note**

- Both “Geometry Manager Pro” and the “Auto Screen Adjustment plug-in software” must be installed to use the Auto Screen Adjustment function.
- To use the Auto Screen Adjustment function, prepare a camera separately. *Camera connection* (page 88)
Starting and Exiting the Application

Starting the application

Double-click the shortcut icon on the desktop. When the application starts, the connection settings screen appears.

Select [LAN] to use a LAN connection for the projector and computer, and select [Load from file] to connect by loading a saved file.

The following items can be selected from the [Option] menu at the top left of the connection settings screen.

**Activation (ET-CK10P)**
- This performs Auto Screen Adjustment upgrade kit (PC) activation.

**Export Volume Serial**
- This creates a volume serial file (file registered to PASS).
- This file is required to acquire the activation code file.
  > “Activation” (page 12)

**Activation Software License**
- This performs computer activation. An activation code file or activation code is required.
  > “Activation” (page 12)

**Service Password**
- This menu is used to support maintenance by Panasonic. It is not normally used.

**Version**
- This is where the application's version information can be checked.
Starting and Exiting the Application

Starting the application

LAN connection

Select [ ] and configure the following settings.

**IP Address**
Input the IP address of the projector to be connected to the computer. When searching for a connected projector, enter an IP address to start searching.

**End IP Address**
When searching for a connected projector, select the check box and enter an IP address to end searching.

**NOTE**
- Specify the same network address for the IP Address and End IP Address.
- If the search range is too wide, an error will occur when you start the search.

**Port**
Set the number of port on the computer for connecting with the projector.

**User Name**
Input the user name used for WEB control of the connected projector.

**Password**
Input the password used for WEB control of the connected projector.

When not searching for a connected projector, click [Connect] after configuring the settings to display the main screen. (page 24)

When searching for a connected projector, click [Search] after configuring the settings to start the search according to the settings. The projector search screen is displayed while the search is in progress.

[Image of Lan Connection Settings]

- **Cancel**
  Cancel the search. When a search is canceled, projectors that have been detected up to that point will be displayed.

- **Connected projector list**
  Displays a list of projectors that were detected via the search.

- **Connect**
  Connect to the selected projectors, and display the main screen. (page 24)

- **Clear All**
  Clear selection of all detected projectors.

- **Select All**
  Select all detected projectors.

When [Exit] is clicked, the application is exited without establishing a connection.
Starting andExiting the Application

File connection

Select [Load from file] and configure the following settings.

File path

Specify a file (with .prjc or .prjs extension) saved in the past.

Click [Select] to open the file selection screen.

After performing the settings, click [Connect] to display the main screen. **"Adjustment and Settings – Main screen"** (page 24)

When [Exit] is clicked, the application is exited without establishing a connection.

Note

The following screen appears when you connect to a projector for which the upgrade kit (ET-UK20) has not been applied.

Exiting the application

To exit the connection main screen, either select [File] and then [Exit] or click the button at the top right of the window.

To exit the connection settings screen, either click the [Exit] button or click the button at the top right of the window.
Adjustment and Settings

Main screen

The main screen consists of the following five general areas and the AUTO ADJUST (Auto Screen Adjustment) button.

- Main menu
- Adjustment area
- AUTO ADJUST (Auto Screen Adjustment) button
- Icon menu
- Common operation area
- Status bar

Note

- When using this application, keep the main power of the projector in the “on” setting. If the standby mode is set to [Normal], the [Power ON] operation is enabled even when the projector is in standby mode. However, if the standby mode is set to [ECO], all operations including [Power ON] will be disabled. When using this application and performing the [Power ON] operation, set the projector’s standby mode to [Normal]. Operations other than [Power ON] are not guaranteed, when the standby mode is set to [Normal].
- If the projector settings have been changed using a remote control, for instance, rather than the software application, the software application displays and projector settings may not match.

Adjustment area

You can click the tabs in the adjustment area to switch between screens and perform various adjustments and operations. The modes in which these adjustments and operations are performed are called “editing modes.”
Main menu

File submenu

Open File (Current Tab)
This loads only the setting data of the current editing mode from a setting file (with .prj extension) saved on the computer.
- When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Open File (One Projector)
This loads all the editing mode settings from the setting file (with .prj extension) saved on the computer into the selected projector.
When this menu item is selected, the loaded settings are reflected in the target projector even if Auto Transfer (at the bottom of the common operation area) has not been checked.
- When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Note
When the setting file is loaded, the settings may not be reflected correctly if the selected input signal is not the same as the one when the setting file was saved.

Open File (All Projectors)
This loads a file saved with [Save File (All Projectors) As...].
When this item is selected, the loaded settings are reflected in all the target projectors that are connected even if Auto Transfer (at the bottom of the common operation area) is not checked.
- When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Note
When the file is loaded, an error message is displayed if the target projector is not connected to the network. When the connection of the target projector to the network is recognized, the connection is established and the loaded settings are reflected automatically.

Open File (Connection Only)
This loads a setting file (with .prjc or .prjs extension) saved to the computer and reflects the status of the connection with the saved projector.

Note
- When the file is loaded, an error message will be displayed if the target projector is not connected to the network, but a connection will be established automatically when the computer recognizes that the target projector is connected to the network.
- Even if a setting file (with .prjs extension) is selected, the settings of the projector target for connection are not reflected.

Save File (One Projector)
This saves the settings being edited, overwriting the previous settings in the current setting file (with .prj extension).
When the file is saved for the first time, a message appears prompting the user to provide a filename.

Save File (One Projector) As...
This saves the settings now being edited in a file under the filename (with .prj extension) provided.

Save File (All Projectors) As...
This saves the setting information of all the currently connected projectors as a single All Project File (with .prjs extension) on the computer.
The layout information, IP addresses, user names, and passwords of the projectors are also encrypted and saved in the All Project File.
Save File (Connection Only) As...
This saves the connection information of all the currently connected projectors as a single file (with .prjc extension) on the computer.
The IP addresses, user names, and passwords of the projectors are also encrypted and saved.

Reset Data (Current Tab)
This sets the current editing mode settings to the initial statuses.
- When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Reload (Current Tab)
This cancels the settings currently being edited using the application, and loads the same settings again from the projector.
- When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Activation
Export Equipment Profile (ET-UK20 / ET-CUK10 / ET-CUK10P)
Creates a file to be registered in PASS. This file is required to acquire the activation code file.
☞ “Activation” (page 12)

Activate License (ET-UK20 / ET-CUK10 / ET-CUK10P)
Select [ET-UK20], [ET-CUK10], or [ET-CUK10P] and then perform activation.
☞ “Functions which are expanded as a result of activation” (page 20)
- The activation code file is required.
  ☞ “Activation” (page 12)
- If the “Auto Screen Adjustment plug-in software” is not installed, [ET-CUK10] or [ET-CUK10P] cannot be selected.
  ☞ “Installing the “Auto Screen Adjustment plug-in software”” (page 8)

Export
Multi Monitoring and Control Software
This saves the data in the file format (with .ugk extension) used for the “Multi Monitoring & Control Software”.
The file is for registering the data of the projectors already registered in the software application in the “Multi Monitoring & Control Software” for monitoring and control purposes.
For details, refer to the operation manual of the “Multi Monitoring & Control Software”.

Exit
Exits the software.
- When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
Edit submenu

Undo
This discards the software application and projector settings currently being edited.
It returns these settings to the status before the setting data is sent.

Redo
This returns the settings to the ones before the Undo operation is performed.

Note
- Undo and Redo can be used up to 50 times during a single setting process (for each editing mode).
- The Undo and Redo logs are cleared if you switch to another editing mode or projector.

The following Edit submenu items are enabled only in certain editing modes. For details, refer to the respective reference pages.

Lock
☞ “Adjustment and Settings – Geometry Correction” (page 41)

Unlock
☞ “Adjustment and Settings – Geometry Correction” (page 41)

Free
☞ “Adjustment and Settings – Geometry Correction” (page 41)

Reset
☞ “Adjustment and Settings – Geometry Correction” (page 41), “Adjustment and Settings – Uniformity” (page 60),
  “Adjustment and Settings – Masking” (page 69)

Flip Vertical
☞ “Adjustment and Settings – Geometry Correction” (page 41), “Adjustment and Settings – Uniformity” (page 60),
  “Adjustment and Settings – Masking” (page 69)

Flip Horizontal
☞ “Adjustment and Settings – Geometry Correction” (page 41), “Adjustment and Settings – Uniformity” (page 60),
  “Adjustment and Settings – Masking” (page 69)

Area Select
☞ “Adjustment and Settings – Uniformity” (page 60)

Point Select
☞ “Adjustment and Settings – Uniformity” (page 60)
View submenu

Tool Bar, Status Bar, Sub Window, Layout Window
Enter a check mark, and select whether the items are to be displayed.
In the initial status, “Tool Bar” and “Status Bar” are displayed.

Auto Transfer
When a check mark is entered for this and then settings are changed, the changed settings are reflected in the projector as soon as they are changed.
• Entering a check mark causes a check mark to appear in the lower left of the common operation area.

Line Color
White / Red / Green / Blue
These perform the same operations as the icon menu [White], [Red], [Green] and [Blue] on the Geometry screen.
☞ “Adjustment and Settings - Geometry Correction - Geometry screen” (page 41)

Coordinate Information
None / Absolute / Relative
These select the mode in which the coordinates of the control points are displayed.
☞ “Adjustment and Settings - Main screen - Coordinate Information” (page 35)

Grid Resolution
Use Square Grid / X / Y
These select the mode in which the coordinates of the control points are displayed.
☞ “Adjustment and Settings - Geometry Correction - Geometry screen” (page 41)

Zoom
x1/8 / x1/4 / x1/2 / x1 / x2 / x3 / x4 / x5 / x6 / x7 / x8
The editing area is zoomed in or out.

Masking Marker
Red / Green / Blue / Orange
These select whether to display the control points.
☞ “Adjustment and Settings - Masking - Masking screen” (page 69)

Tools submenu

Command Control
This displays the Command Control screen.
☞ “Projector Control” (page 86)

Auto Screen Adjustment
This displays the Auto Screen Adjustment screen.
This performs the same operation as the [AUTO ADJUST] (Auto Screen Adjustment) button.
☞ “AUTO ADJUST (Auto Screen Adjustment) button” (page 36)

Note
This cannot be selected if the “Auto Screen Adjustment plug-in software” is not installed.

Version submenu

About Geometry...
This displays version information for “Geometry Manager Pro”.
Icon menu

This icon menu is used in all the editing modes. For details on the icon menu items used in each editing mode, refer to the description of the mode concerned.

Open File (One Projector)
This performs the same operation as [Open File (One Projector)] on the File submenu.

Save File (One Projector)
This performs the same operation as [Save File (One Projector)] on the File submenu.

Reload (Current Tab)
This performs the same operation as [Reload (Current Tab)] on the File submenu.

Undo
This performs the same operation as [Undo] on the Edit submenu.

Redo
This performs the same operation as [Redo] on the Edit submenu.

Layout Window
Each time this is clicked, the Layout Window screen is switched between displayed and cleared. On the Layout Window, the positions of the projectors can be changed by means of mouse operations. When a projector position is moved, the overall layout is automatically corrected based on the projector which was moved. Main screen operations can be performed even while the Layout Window is displayed. The Layout Window screen can be displayed also by selecting [Layout Window] on the View submenu. The Layout Window screen below is an example when eight projectors are connected.

Selection area
The projector layout is displayed. You can change the active projector by clicking one of the rectangles representing the projectors. The frame of the selected projector is indicated in red.

Apply
Click to apply the layout displayed in the selection area. The screen is not closed.

Cancel
Click to close the screen without applying the layout displayed in the selection area.

OK
Click to apply the layout displayed in the selection area and close the screen.

Reset Data (Current Tab)
This performs the same operation as [Reset Data (Current Tab)] on the File submenu.

Open File (Current Tab)
This performs the same operation as [Open File (Current Tab)] on the File submenu.
Common operation area

The common operation area houses the operations which can be used in all the editing modes.

Projector list
This list displays the projector numbers, projector names and IP addresses in the sequence in which the projectors were connected.

The projector currently selected is the one whose data is being edited. Any projector on the list can be selected to switch the projector whose data is to be edited.

Note
- Multiple projectors can be selected as targets for operations by holding the Ctrl key while clicking. In that case, the following functions can be operated.
  - Power ON/Standby, Shutter Close/Shutter Open, OSD ON/OSD OFF, Status ON/Status OFF, Status Page, Test Pattern, Display Projector Name, Grid Resolution, Display Grid Lines
- When a projector for which the upgrade kit (ET-UK20) has not been applied is connected, an asterisk (*) appears to the left of that projector name. An error message will appear if you connect to this projector and attempt to use the extended functions. See "Activation" (page 12)
- When a projector on the list is selected and then double-clicked, the WEB control screen opens. For details on the WEB control screen, refer to the operating instructions of the projector.
- When the mouse pointer is placed over a projector on the list, a tooltip appears and shows the model number and resolution of that projector.

/ / These change the order of the projectors in the list.
Select a projector in the list and then click the up arrow button to move it up one place in the list or click the down arrow button to move it down one place in the list.

Note
- Multiple projectors cannot be moved at the same time.
- When the up arrow button is clicked while the very top projector is selected or when the down arrow button is clicked while the very bottom projector is selected, the projector does not move.
- The results of moving the projectors are reflected in Layout Window. See "Layout Window" (page 29)

Del
Click to remove the selected projector from the operating targets.
When all the projectors are removed, the software is exited.
Add
Click to display the LAN connection destination selection screen and add a new projector.

Rename
Click to change the name of the currently selected projector.
A name can consist of a maximum of 12 characters including letters (upper-case), numbers, hyphens and periods.

Display Projector Name
Click to display the name and number of the currently selected projector on the image projected by the projector.
LAN connection destination selection screen

When \( \text{Add} \) is clicked, the LAN connection destination selection screen is displayed.
A projector that is going to be connected now be set.

- **IP Address**
  - Input here the IP address of the projector to be connected.
  - To search for a connected projector, enter an IP address to start searching.

- **End IP Address**
  - To search for a connected projector, select the check box and enter an IP address to end searching.
  - **Note**
    - Specify the same network address for the IP Address and End IP Address.
    - If the search range is too wide, an error will occur when you start the search.

- **Port**
  - Set here the number of the port that is to be connected to the projector.

- **User Name**
  - Input here the user name of the projector to be connected.

- **Password**
  - Input here the password of the projector to be connected.

- **Exit**
  - Click to cancel the connection with the projector and close the LAN connection destination selection screen.

- **Connect / Search**
  - When not searching for a connected projector, connection to the projector will be established according to the entered settings.
  - When searching for a connected projector, the projector search will start according to the entered settings.
  - A status screen is displayed while the search is in progress. \( \xrightarrow{\text{}} \) "Starting and Exiting the Application − Projetor Search Screen" (page 22)
  - When the projector is connected successfully, the LAN connection destination selection screen is closed.
Adjustment and Settings

Main screen

**Power ON/Standby**
Click the left button to set the power of the selected projector to the “On” state or click the right button to set it to the standby state.
The setting is reflected in the projector even when a check mark has not been entered in

**Note**
When the projector is in the standby state, no guarantees are made for any operations except [Power ON].

**Shutter Close/Shutter Open**
Click the left button to set the shutter of the selected projector to the “On” state or click the right button to set it to the “Off” state.
The setting is reflected in the projector even when a check mark has not been entered in

**OSD ON/OSD OFF**
Click these to select to display (ON) or not display (OFF) the OSD menu on the images of the selected projector.
This operation is reflected in the projector even if a check mark has not been entered for

**Status ON/Status OFF**
Click these to select to display (ON) or not display (OFF) the status (information) on the images of the selected projector.
The setting is reflected in the projector even when a check mark has not been entered in

**Status Page**
Click these to select the previous or next page of the status screen when the status is displayed on the projector’s image.
The setting is reflected in the projector even when a check mark has not been entered in

**Test Pattern**
Click to switch the image projected from the projector to the test pattern.
Any of the following test patterns can be selected.

- OFF, White, Black, Red, Green, Blue, Cyan, Magenta, Yellow, Window, Window (Inversion), Colorbars (Vertical), Colorbars (Horizontal), 16:9 / 4:3, Crosshatch (White), Crosshatch (Red), Crosshatch (Green), Crosshatch (Blue), Crosshatch (Cyan), Crosshatch (Magenta), Crosshatch (Yellow)

Default value: OFF
The setting is reflected in the projector even when a check mark has not been entered in
Adjustment and Settings

Main screen

When a check mark is entered for **Use Square Grid**, the two grid resolutions (horizontal and vertical) become one, and the button for selecting the combination of the number of grids whose horizontal and vertical intervals are identical is selected. Any of the following numbers of square grids can be selected.

- When the resolution of the projector is 1920 x 1200 dots or 3840 x 2400 dots:
  - 41x26*, 33x21*, 25x16*, 17x11*, 9x6
- When the resolution of the projector is 1400 x 1050 dots:
  - 29x22*, 21x16*, 9x7, 5x4

* Selectable if the upgrade kit (ET-UK20) has been applied to the projector.

“Activation” (page 12)

---

Grid Resolution (horizontal)
The number of grids in the horizontal direction is selected here.

Grid Resolution (vertical)
The number of grids in the vertical direction is selected here. Any of the numbers of grids listed below can be selected.

- When the resolution of the projector is 1920 x 1200 dots or 3840 x 2400 dots:
  - Horizontal: 2 to 41\(^*1\) (2 ~ 11)\(^*2\) (default value: 11)
  - Vertical: 2 to 26\(^*1\) (2 ~ 11)\(^*2\) (default value: 11)
- When the resolution of the projector is 1400 x 1050 dots:
  - Horizontal: 2 to 29\(^*1\) (2 ~ 11)\(^*2\) (default value: 11)
  - Vertical: 2 to 22\(^*1\) (2 ~ 11)\(^*2\) (default value: 11)

\(^*1\) Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.

\(^*2\) Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.

“Activation” (page 12)

Display Grid Lines
The color of the grids to be projected is selected here.

OFF, White, Black, Red, Green, Blue, Cyan, Magenta, Yellow

Default value: OFF
The setting is reflected in the projector even when a check mark has not been entered in

**Auto Transfer**
Cursor Information

When a check mark is entered for \( \text{Display Cursor} \), the cursor indicating the position of the control point can be displayed on the projected image.

Note

The cursor appears only at the top left when the control point has been selected using a line or area.

If a multiple number of control points have been selected, the cursor will be displayed only at the control point selected last.

Coordinate Information

The mode in which to display the control point coordinates is selected here when grids have been set in one of the editing modes.

- **None**: The coordinates are not displayed.
- **Absolute**: The coordinates with the top left control point used as the origin point are displayed alongside the control points.
- **Relative**: The coordinates with the initial position of the control point in the selected grid used as the origin point are displayed alongside the control points.

Note

However, if the grid intervals are narrow, the coordinates may not be displayed even when Absolute or Relative has been selected.

Manual Transfer

When this button is clicked, the edited settings are reflected in the projector.

When a check mark is entered in \( \text{Auto Transfer} \), as soon as a setting is changed, that setting is reflected in the projector.
**AUTO ADJUST (Auto Screen Adjustment) button**

This allows automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape of the screen through use of an externally connected camera. Click the [AUTO ADJUST] button to display the Auto Screen Adjustment screen.

*Note*

If you click the [AUTO ADJUST] button while the “Auto Screen Adjustment plug-in software” is not installed, a message indicating that installation of the plug-in software is required will appear.

*Note* “Installing the “Auto Screen Adjustment plug-in software”” (page 8)

**Status bar**

This is where the progress made in the data transfer, error messages and expansion ratio of the editing area are displayed.
Lens Settings

Lens setting screen

The lens settings are selected on this screen.

1. **Upward**
   Use this to move the projected image upward.
   When you click and hold the button, the movement speeds up as with operations on the remote control.
   There may be three buttons depending on the projector model.
   In such cases, the amount of movement increases progressively for each button in the following order: ①, ②, ③.

2. **Leftward**
   Use this to move the projected image toward the left.
   When you click and hold the button, the movement speeds up as with operations on the remote control.
   There may be three buttons depending on the projector model.
   In such cases, the amount of movement increases progressively for each button in the following order: ④, ⑤, ⑥.

3. **Rightward**
   Use this to move the projected image toward the right.
   When you click and hold the button, the movement speeds up as with operations on the remote control.
   There may be three buttons depending on the projector model.
   In such cases, the amount of movement increases progressively for each button in the following order: ⑦, ⑧, ⑨.
4 DOWNWARD
Use this to move the projected image downward.
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the amount of movement increases progressively for each button in the following order: 

5 VERTICAL POSITION
Specify the vertical position of the image as a numerical value.
Move to the specified position by clicking the [Apply] button.
This function can be used only for projectors that have this function.

6 HORIZONTAL POSITION
Specify the horizontal position of the image as a numerical value.
Move to the specified position by clicking the [Apply] button.
This function can be used only for projectors that have this function.

7 HOME POSITION
Click to move the lens position to the home position.

8 LENS CALIBRATION
Click to automatically set the limit to which the lens is to be moved and the home position of the lens.

9 LENS FOCUS (FAR)
Click these buttons to adjust the focus to “far”.
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the further toward the left the button is located, the further the focus will move.

10 LENS FOCUS (NEAR)
Click these buttons to adjust the focus to “near”.
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the further toward the right the button is located, the closer the focus will move.

11 LENS FOCUS
Specify the focus position as a numerical value.
Move to the specified position by clicking the [Apply] button.
This function can be used only for projectors that have this function.

12 LENS ZOOM (TELE)
Click these buttons to reduce the size of the projected image (zoom out).
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the image is reduced in progressively larger steps by clicking the buttons progressively further toward the left.

13 LENS ZOOM (WIDE)
Click these buttons to enlarge the size of the projected image (zoom in).
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the image is enlarged in progressively larger steps by clicking the buttons progressively further toward the right.

14 LENS ZOOM
Specify the zoom position as a numerical value.
Move to the specified position by clicking the [Apply] button.
This function can be used only for projectors that have this function.
Lens Settings

⑮ Lens Memory Save
Click these buttons to save the focus position, shift position and zoom position of the adjusted lens in the projector's lens memory.
The number of lens memories available for saving lens settings varies according to model.
Even if a check mark has not been entered for [Auto Transfer], the settings are saved in the lens memory when the [Save] button is clicked.
This function can be used only for projectors that have this function.

⑯ Lens Memory Load
Click these buttons to select and load the lens memory whose settings are saved in the projector.
The lens will move automatically to the saved focus position, zoom position and shift position.
Even if a check mark has not been entered for [Auto Transfer], the settings are loaded from the lens memory when the [Load] button is clicked.
This function can be used only for projectors that have this function.

⑰ Lens Memory Rename
Click these buttons to rename the lens memory settings.
When one of the buttons is clicked, the [Rename] screen is displayed.

![Rename Screen]

When a new name is input and the [OK] button is clicked, the [Rename] screen is closed, and the name of the projector's lens memory settings is changed.
A name can consist of a maximum of 16 characters including letters, numbers, hyphens and periods.
If the [Cancel] button is pressed instead, the [Rename] screen is closed without renaming the lens memory settings.
This function can be used only for projectors that have this function.

⑱ Lens Memory Delete
Click these buttons to delete the settings saved in the lens memory of the projector.
Even if [Auto Transfer] is not checked, the settings are deleted from the lens memory when the [Delete] button is clicked.
This function can be used only for projectors that have this function.

⑲ Lens Type
Specify the lens part number.
This function can be used only for projectors that have this function.

⑳ Lens ID
Specify ALL or a value within the range of 1 to 255 for the ID used for lens identification.
This function can be used only for projectors that have this function.

㉑ Lens Name
Specify the lens name.
A name can consist of a maximum of 12 characters including letters, numbers, hyphens, and periods.
This function can be used only for projectors that have this function.
Active Focus
Enable or disable the active focus optimizer function.
This function can be used only for projectors that have this function.

Focus Offset
Set the focus correction amount for when the maximum specified brightness has entered the lens or when little light enters the lens in Bright and Dark, respectively.
This function can be used only for projectors that have this function.

Test Pattern
Select the test pattern for adjustment with the active focus optimizer function.
This function can be used only for projectors that have this function.

Initialize
Initialize the Focus Offset value.
This function can be used only for projectors that have this function.
**Geometry Correction**

Test patterns or grids are projected onto the screen and those parts of the image that look unnatural are corrected. By adjusting the number of grids or number of control points, the images can be made to look more natural. Use the mouse to make coarse corrections, and use the cursor keys on the keyboard or input numerical values to make fine corrections.

- Drag the control point with the mouse while holding down the Shift key to move it in either the horizontal or vertical direction.
- Select the control point and then press the cursor key while holding down the Ctrl key to move it in increments of 0.2 pixel.
- Select the control point and then press the cursor key while holding down the Alt key to move it in increments of 4 pixels.

**Note**

When the number of grids displayed during ongoing adjustments is reduced, the corrected grid information may be lost. It is recommended that a small number of grids be displayed first to make coarse adjustments and then a larger number of grids be displayed to make fine adjustments.

**Geometry screen**

1. **Sub Window**
   - Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
   - An image of the entire projection area is displayed on Sub Window.
   - The red frame around the Sub Window indicates the display range in the editing area.
   - Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.

2. **Zoom In**
   - Zooms in to the editing area.

3. **Zoom Out**
   - Zooms out the editing area.
Adjustment and Settings  Geometry Correction

④ White
This corrects the RGB color components together.

⑤ Red, Green, Blue
These correct only the component of the selected color.

⑥ Editing Area
The image can be corrected by selecting the grid using the mouse.
The settings established in the operation area are also reflected in this area.
The outermost red frame indicates the maximum area which can be projected.

⑦ Operation Area
This is where the buttons, slide bars, etc. used by geometry correction are displayed.
The operations that they perform differ depending on which correction pattern has been selected.
☞ “Operation area” (page 43)

⑧ Edit, View
The following menu items can be used on the Geometry screen.

**Edit submenu**

**Lock**
Locks the control points of the grids selected.

**Note**
A locked control point will not move even if the correction pattern has been changed.
The lock will not be released even if the number of grids has been changed.

**Unlock**
Unlocks the control points that have been selected.

**Free**
Click to release the control point selection.

**Reset**
Click to return the selected control points to the initial status.

**Flip Vertical**
Click to flip vertically the correction status of the entire image.

**Flip Horizontal**
Click to flip horizontally the correction status of the entire image.

**View submenu**

**Grid Resolution**

**Use Square Grid**
This makes it possible to select the combination of the number of grids which can be selected when a check
mark has been entered for the Use Square Grid in the common operation area.

**X**
The number of grids in the horizontal direction is selected here.
This performs the same operation as Grid Resolution (horizontal) in the common operation area.

**Y**
The number of grids in the vertical direction is selected here.
This performs the same operation as Grid Resolution (vertical) in the common operation area.
### Operation area

1. **Mode Switching**
   - OFF: Disables geometry correction.
   - PC-1 / PC-2 / PC-3: Enables geometry correction.

   **Note**
   When geometry correction is enabled, only one piece of data (PC) can be saved for some models.

2. **Moving Area**
   Set here the range of the effects exerted on the grids around the control points that have been dragged and moved.

3. **Smoothing**
   Correction using curves can be performed when a check mark is entered in \( √ \text{Smoothing} \).

<table>
<thead>
<tr>
<th>Example when the check mark is entered</th>
<th>Example when the check mark is not entered</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Example" /></td>
<td><img src="image2.png" alt="Example" /></td>
</tr>
</tbody>
</table>

4. **Alert Distortion**
   If a setting exceeding the geometric distortion limit is sent to the projector when \( √ \text{Alert Distortion} \) has been checked, an error message will be displayed on the dialog screen. The error message will be displayed on the status bar if a check mark has been entered in \( √ \text{Auto Transfer} \).

   When a check mark is not entered for \( √ \text{Alert Distortion} \), even settings exceeding the geometry correction limits can be sent to the projector. Bear in mind, however, that in such cases the projected images may lose their shape.

5. **Store**
   Click this button to save the current settings inside the projector.

   **Note**
   A screen for selecting the save folder inside the projector may appear for some models.

6. **Display Switching**
   Click \( ▼ \) to minimize the operation area; conversely, click \( ▲ \) to maximize it.
Selecting the control points

Select the Geometry screen and switch the mode to other than OFF. The control points can now be selected.

“Free Grid (Free-form correction)” (page 45)

Drag the control points to move them. The control points cannot be moved by selecting the lines.

A multiple number of control points can be selected by dragging and enclosing the points where the grids intersect.

The control points can be selected using lines by clicking the space between one point where the grids intersect and another such point.

The control points can be selected using a multiple number of lines by dragging and enclosing the spaces between one point where the grids intersect and another such point.

When a point where the grids intersect is clicked, it can be selected as a single control point.

By clicking (or dragging) while holding down the Ctrl key, another control point can be selected while the currently selected control point keeps selected.

To move the selection to the adjacent control point, press the Tab key or Shift + Tab keys while one control point is selected, or press the cursor key while holding down the Shift key.

To cancel the selection of the control point, click anywhere other than the grid with the mouse or select [Free] in the Edit submenu displayed by right-clicking.

Right-clicking

The menu with the items described below is displayed when a grid control point is selected and the right button of the mouse is clicked.

The menu functions are the same as with the Edit submenu.

“Edit submenu” (page 42).

Lock, Unlock, Free, Reset, Flip Vertical, Flip Horizontal
Free Grid (Free-form correction)

The Free Grid operation area is where the operations for all the correction patterns are selected. The corrections made with Free Grid are also reflected in the editing area of the other correction patterns.

Correction Patterns

Any of the following correction patterns can be selected.

- Free Grid (free-form correction)
- 4 Corner (4-corner correction)
- Keystone (keystone shape correction)
- Cylindrical screen (cylindrical shape correction)
- Elliptical screen (elliptical shape correction)
- Spherical screen (spherical shape correction)
- Rotation (rotational correction)

The Upgrade Kit (ET-UK20) must be applied on the selected projector to enable the Auto Screen Adjustment function.

4 Corner (4-corner correction)

The positions of the four corners of the image are set with this type of correction.

Upper Left

Set the horizontal and vertical positions of the upper left.
Setting ranges:
- V (vertical position): -400 to 600 (when the resolution of the projector is 3840×2400 dots)
- -200 to 600 (when the projector resolution is other than the above)
- H (horizontal position): -400 to 768 (when the resolution of the projector is 3840×2400 dots)
- -200 to 600 (when the projector resolution is other than the above)
2. **Lower Left**
   Set the horizontal and vertical positions of the lower left.
   Setting ranges V (vertical position):
   - -600 to 400 (when the resolution of the projector is 3840×2400 dots)
   - -600 to 200 (when the projector resolution is other than the above)
   H (horizontal position):
   - -400 to 768 (when the resolution of the projector is 3840×2400 dots)
   - -200 to 600 (when the projector resolution is other than the above)

3. **Upper Right**
   Set the horizontal and vertical positions of the upper right.
   Setting ranges V (vertical position):
   - -400 to 600 (when the resolution of the projector is 3840×2400 dots)
   - -200 to 600 (when the projector resolution is other than the above)
   H (horizontal position):
   - -768 to 400 (when the resolution of the projector is 3840×2400 dots)
   - -600 to 200 (when the projector resolution is other than the above)

4. **Lower Right**
   Set the horizontal and vertical positions of the lower right.
   Setting ranges V (vertical position):
   - -600 to 400 (when the resolution of the projector is 3840×2400 dots)
   - -600 to 200 (when the projector resolution is other than the above)
   H (horizontal position):
   - -768 to 400 (when the resolution of the projector is 3840×2400 dots)
   - -600 to 200 (when the projector resolution is other than the above)

5. **Reset**
   Click these to reset the respective settings which have been changed.

6. **Rotation [degree]**
   Set the rotational angle of the image here.
   Setting range: Enter a setting from -10.0 to 10.0.

7. **Fit Size**
   Projected images sometimes protrude beyond the projection area when they are rotated.
   When a check mark is entered for [Fit Size], the image is reduced to a size in which it can be projected when it exceeds the projection area.
   The image will not be reduced if a check mark is not entered.

8. **Linearity**
   Set the linearity in the horizontal and vertical directions.
   When a check mark is entered for [Auto], the linearity values are determined automatically from the positions of the upper, lower, left, right, and four-corner points. In this case, values cannot be set.
   Setting range: -127 to 127
   This function can be used only for projectors that have this function.

9. **Pincushion**
   Set the pincushion independently for upper, lower, left, and right.
   Setting range
   - Upper: -100 to 100*1 (-50 to 50)*2
   - Lower: -100 to 100*1 (-50 to 50)*2
   - Left: -100 to 100*1 (-50 to 50)*2
   - Right: -100 to 100*1 (-50 to 50)*2
   *1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
   *2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.

10. **Import from CORNER CORRECTION**
   Reflect the [CORNER CORRECTION] and [CORNER/PINCUSHION] adjustment items in the OSD menu of the projector.
   This is available only for models that have the CORNER/PINCUSHION and CORNER/PINCUSHION adjustment functions in the projector.

---

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.

☞ “Activation” (page 12)
Keystone (keystone shape correction)

Images are corrected using the keystone shape as the reference with this type of correction.

1. Correction pattern adjustment area
The following settings are selected here:

- Vertical: –45.0 to 45.0°
- Horizontal: –40.0 to 40.0°
- Vertical balance: –60 to 60
- Horizontal balance: –30 to 30

The numbers in parentheses serve as the setting ranges if the selected projector has not been activated.

*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.

"Activation" (page 12)

2. Reset
Use these to reset the settings that have been changed.

3. Setting
The following settings are selected here:

- Lens Throw Ratio: 0.7 to 16.5
- V Keystone [degree]: –45.0 to 45.0°
- H Keystone [degree]: –40.0 to 40.0°
- V Balance: –60 to 60
- H Balance: –30 to 30
- Rotation [degree]: –10.0 to 10.0

*1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
*2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.

"Activation" (page 12)

4. Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for the Fit Size, the image is reduced to a size in which it can be projected when it exceeds the projection area.

The image will not be reduced if a check mark is not entered.

5. Import from KEYSTONE
Reflect the correction results of [KEYSTONE] in the OSD menu of the projector.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.

"Activation" (page 12)
Cylindrical screen (cylindrical shape correction)

Images are corrected using the cylindrical shape as the reference with this type of correction.

1. **Correction pattern adjustment area**
   The following settings are selected here:
   - Vertical arc: $-100$ to $100^\circ$ ($-50$ to $50^\circ$)\(^1\)
   - Horizontal arc: $-100$ to $100^\circ$ ($-50$ to $50^\circ$)\(^2\)

   \(^1\) Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
   \(^2\) Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.

2. **Reset**
   Use these to reset the settings that have been changed.

3. **Setting**
   The following settings are selected here:
   - Lens Throw Ratio: $0.7$ to $16.5$
   - V Keystone [degree]: $-45.0$ to $45.0^\circ$ ($-40.0$ to $40.0^\circ$)\(^1\)
   - H Keystone [degree]: $-40.0$ to $40.0^\circ$ ($-15.0$ to $15.0^\circ$)\(^2\)
   - V Arc: $-100$ to $100^\circ$ ($-50$ to $50^\circ$)\(^2\)
   - H Arc: $-100$ to $100^\circ$ ($-50$ to $50^\circ$)\(^2\)
   - V Balance: $-60$ to $60$
   - H Balance: $-30$ to $30$
   - Rotation [degree]: $-10.0$ to $10.0$

   \(^1\) Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
   \(^2\) Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.

4. **Fit Size**
   Projected images sometimes protrude beyond the projection area when they are rotated.
   When a check mark is entered for **Fit Size**, the image is reduced to a size in which it can be projected when it exceeds the projection area.
   The image will not be reduced if a check mark is not entered.

---

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.

* “Activation” (page 12)
5 Import from CURVED CORRECTION
Reflect the correction results of [CURVED] in the OSD menu of the projector.

6 Maintain Aspect Ratio
When a check mark is entered for [Maintain Aspect Ratio], correction is made so that the aspect ratio of the projected image is maintained.
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the display device.
This function can be used only for projectors that have this function.
Elliptical screen (elliptical shape correction)

Images are corrected to fit a screen whose shape is elliptical when viewed from above.

Correction pattern adjustment area
The following settings are selected here:

- Width/Radius Ratio: 0.01 to 1.20
- Flattening: 0.50 to 2.00
- Azimuth: −45.0 to 45.0
- Vertical balance: −60 to 60

Reset
Use these to reset the settings that have been changed.
### Adjustment and Settings

#### Geometry Correction

3. **Setting**

The following settings are selected here:

- Lens Throw Ratio: 0.7 to 16.5
- V Keystone [degree] (Vertical keystone correction): –45.0 to 45.0°¹ (–40.0 to 40.0°²)
- H Keystone [degree] (Horizontal keystone correction): –40.0 to 40.0°¹ (–15.0 to 15.0°²)
- Width/Radius Ratio: 0.01 to 1.20
- Flattening: 0.50 to 2.00
- Azimuth: –45.0 to 45.0
- V Balance: –60 to 60
- Rotation [degree]*: –10.0 to 10.0

It may not be possible to correct the images depending on how the settings are used in combination, such as a small lens throw ratio (lens with a short focus) and keystone correction with a wide angle.

¹ Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
² Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.

4. **Fit Size***

Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for **Fit Size**, the image is reduced to a size in which it can be projected when it exceeds the projection area.

The image will not be reduced if a check mark is not entered.

5. **Maintain Aspect Ratio**

When a check mark is entered for **Maintain Aspect Ratio**, correction is made so that the aspect ratio of the projected image is maintained.

If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the display device.

This function can be used only for projectors that have this function.

---

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.

*² "Activation" (page 12)
Description of elliptical screen (elliptical shape correction) parameters

View of projector as seen from above

Example of settings

<table>
<thead>
<tr>
<th>Setting item</th>
<th>Calculation method</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lens Throw Ratio</td>
<td>Projection distance + width of image on flat screen</td>
<td>0.9</td>
</tr>
<tr>
<td></td>
<td>= 3 870 mm ÷ 4 300 mm</td>
<td></td>
</tr>
<tr>
<td>H Keystone [degree]</td>
<td>Angle formed with tangent of projection center</td>
<td>14.0</td>
</tr>
<tr>
<td>Width/Radius Ratio</td>
<td>Width of image on flat screen ÷ radius in horizontal direction of ellipse</td>
<td>0.69</td>
</tr>
<tr>
<td></td>
<td>= 4 300 mm ÷ 6 200 mm</td>
<td></td>
</tr>
<tr>
<td>Flattening</td>
<td>Radius in vertical direction of ellipse ÷ radius in horizontal direction of ellipse</td>
<td>0.66</td>
</tr>
<tr>
<td></td>
<td>= 4 110 mm ÷ 6 200 mm</td>
<td></td>
</tr>
<tr>
<td>Azimuth</td>
<td>Position of projected image center on ellipsis</td>
<td>40.0</td>
</tr>
</tbody>
</table>
Spherical screen (spherical correction)

Images are corrected using the spherical shape as the reference with this type of correction.

1. **Correction pattern adjustment area**
   The following settings are selected here:
   - Vertical arc and horizontal arc: –100 to 100° (–50 to 50)°

   *1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
   *2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
   * “Activation” (page 12)

2. **Reset**
   Use these to reset the settings that have been changed.

3. **Setting**
   The following settings are selected here:
   - Lens Throw Ratio: 0.7 to 16.5
   - V Keystone [degree]: –45.0 to 45.0° (–40.0 to 40.0)°
   - H Keystone [degree]: –40.0 to 40.0° (–15.0 to 15.0)°
   - V Arc: –100 to 100° (–50 to 50)
   - V Balance: –60 to 60
   - H Balance: –30 to 30
   - Rotation [degree]*: –10.0 to 10.0

   *1 Selectable values if the upgrade kit (ET-UK20) has been applied to the selected projector.
   *2 Selectable values if the upgrade kit (ET-UK20) has not been applied to the selected projector.
   * “Activation” (page 12)

4. **Fit Size**
   Projected images sometimes protrude beyond the projection area when they are rotated.
   When a check mark is entered for **Fit Size**, the image is reduced to a size in which it can be projected when it exceeds the projection area.
   The image will not be reduced if a check mark is not entered.

5. **Maintain Aspect Ratio**
   When a check mark is entered for **Maintain Aspect Ratio**, correction is made so that the aspect ratio of the projected image is maintained.
   If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the display device.
   This function can be used only for projectors that have this function.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector.
* “Activation” (page 12)
**Adjustment and Settings**

---

**Geometry Correction**

---

**Rotation (rotation correction)**

Images are rotated with this type of correction.

To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector.

☞ “Activation” (page 12)

![Image of Rotation settings interface]

1. **Correction pattern adjustment area**
   The following settings are selected here:
   - **Gradient**: –10.0 to 10.0

2. **Reset**
   Use these to reset the settings that have been changed.

3. **Setting**
   The following settings are selected here:
   - **Rotation [degree]**: –10.0 to 10.0

4. **Fit Size**
   Projected images sometimes protrude beyond the projection area when they are rotated.
   When a check mark is entered for **Fit Size**, the image is reduced to a size in which it can be projected when it exceeds the projection area.
   The image will not be reduced if a check mark is not entered.
**Edge Blending**

**Mode Switching**

**OFF:**
The edge blending settings are canceled.

**ON:**
Makes the edge blending settings effective.

**User:**
Adjusts settings for edge blending using the user-defined curve.

**Note**
When the input signal of the projector has been changed, it may be necessary to re-set the edge blending mode and the Upper, Lower, Left and Right Enable boxes.

**Marker**
When a check mark is entered in the Marker, markers are displayed in the editing area and on the images projected from projector.
The start position for edge blending is indicated by display of a green line, and the edge blending width is indicated by display of a red line.
☞ “Editing Area” (page 57)

**Setting**
Click this button to display the user-defined curve setting screen.
☞ “User-defined curve setting screen” (page 58)

**Upper**
The upper side settings of the projected image are set here.
Adjustment and Settings

Edge Blending

⑤ Left
The left side settings of the projected image are set here.

⑥ Right
The right side settings of the projected image are set here.

⑦ Lower
The lower side settings of the projected image are set here.

⑧ Enable
Put a check mark in [Enable] to create blending settings for that edge. Only the edge blending settings for those items with a check mark entered in [Enable] take effect.

Note
When the input signal of the projector has been changed, it may be necessary to re-set the edge blending mode and the Upper, Lower, Left and Right Enable boxes.

⑨ Start
The starting position of edge blending is set here.

⑩ Width
The width of the edge blending is set here.

⑪ Black Border (Outside Area)
Set the border width of the black level.
[Outside Area] may be displayed in place of [Black Border] for some models.

⑫ Keystone Area
Set the slope of the black level border when using the edge blending at the same time as the keystone correction.
This function can be used only for projectors that have this function.

⑬ Overlapped Black Level (Bright Blending)
The Red, Green and Blue values are adjusted here to set the brightness of the areas subject to edge blending.
These settings are applied to the edge blending width. The higher the numerical value, the brighter the colors.
Setting range: 0 to 255
[Bright Blending] may be displayed in place of [Overlapped Black Level] for some models.

⑭ Interlocked
When a check mark is entered for [Interlocked], Overlapped Black Level can be set with the Red, Green and Blue values all linked together.

⑮ Non-Overlapped Black Level (Bright Inside)
The black level inside the area where the images are to be superimposed is set here.
When a check mark is removed from [Interlocked], the Red, Green and Blue values can be set separately.
[Non-Overlapped Black Level] may be displayed in place of [Bright Inside] for some models.

⑯ Black Border Level (Bright Outside)
Set the black level of the parts where images are superimposed.
When a check mark is removed from [Interlocked], the Red, Green and Blue values can be set separately.
[Black Border Level] may be displayed in place of [Bright Outside] for some models.
Editing Area

The edge blending setting status is displayed here. By dragging these markers, the start position of the edge blending (green), edge blending width (red), and black level border width (yellow) can be set. The settings established with Upper, Left, Right and Lower are also reflected in this area.

Note

The line for the black level border width (yellow) is displayed only when the mouse cursor is positioned on the marker (yellow).

Edit

In addition to the menu items described in “Main menu” (page 25), the following menu items can be used on the Edge Blending screen.

Edit submenu

Flip Vertical:
Click to flip vertically the correction status of the entire image.

Flip Horizontal:
Click to flip horizontally the correction status of the entire image.
User-defined curve setting screen

When [Setting] is clicked, the user-defined curve setting screen is displayed.
The gradient (brightness gradient) at which edge blending is performed is set using a gamma curve.
When a user-defined curve setting is changed from the initial curve, the display above [Setting] changes from [User Blending Curve: Default] to [User Blending Curve: Changed].

1. **Blending**
The position where the user-defined curve is to be set is selected here.

2. **Copy**
Click this to copy the current user-defined curve setting.
The setting is copied from top to bottom (or vice versa) or from left to right (or vice versa).

3. **Gamma**
The user-defined curve is set here.
For numerical value input: Enter a setting from 0.25 to 4.00 (in 0.01 steps).

4. **Initial Curve**
The initial setting of the user-defined curve is displayed here.

5. **Correction Curve**
The operation point in the center can be dragged to change the user-defined curve setting (shape of the gamma curve).

6. **Store**
Click this to reflect the currently displayed user-defined curve setting in the projector and save the setting in the projector.
The setting remains saved even when the main power of the projector has been set to “off”.

7. **Reset**
Click this to reset the currently displayed user-defined curve setting and return it to the initial value.
Adjustment and Settings  Edge Blending

⑧ OK
Click this to reflect the user-defined curve setting in the projector and close the user-defined curve screen.
This operation is reflected in the projector even when a check mark has not been entered in Auto Transfer.

⑨ Apply
Click this to reflect the user-defined curve setting in the editing area.
This operation is reflected in the projector even if a check mark has not been entered for Auto Transfer.

⑩ Cancel
Click this to cancel the setting and close the user-defined curve screen.
Uniformity

Two correction methods can be used for uniformity.

- Gradient Correction
  When unevenness in color occurs in one direction across the image, greater uniformity can be obtained by applying correction in the vertical or horizontal direction. Correction is performed by toning down (thinning) the selected color in a gradient-like manner from one side of the image to the other.

- Flexible Correction
  If other than OFF was selected in Flexible Correction, correction can be performed by specifying ranges for the localized unevenness of colors in the image. When the image contains localized unevenness in color, correction is applied after specifying the range. As with Gradient Correction, correction is performed by toning down (thinning) the selected color in a gradient-like manner.

  "Flexible Correction Procedure" (page 63)

  To use the Flexible Correction function, the upgrade kit (ET-UK20) must be applied on the selected projector.

  "Activation" (page 12)

Uniformity screen

[Diagram showing the Uniformity screen with numbered labels for each section.]

[1] Uniformity option
[2] Gradient Correction option
[3] Flexible Correction option
[5] Brightness control
[6] Color matching
[7] Input signal options
[8] User programmable settings

[Detailed description of each section based on the diagram]

60
Adjustment and Settings

Uniformity

① Sub Window
Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
The Sub Window displays a representation of the Gradient Correction and Flexible Correction settings for the entire projection area.
- Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.

② Zoom In
Zooms in to the editing area.
The center of the target area is zoomed in when the target area has been selected in the editing area.

③ Zoom Out
Zooms out the editing area.

④ Editing Area
A representation of the Gradient Correction and Flexible Correction settings is displayed.
When applying Flexible Correction, this is where you select target points and set the target area.

⑤ Gradient Correction
When applying gradation to the entire image, set the degree of color variation.
You can set this individually for each of the colors White, Red, Green and Blue, both for the vertical direction (V) and the horizontal direction (H).
For numerical value input: Enter a value from -127 to 127.
- How the vertical (V) and horizontal (H) gradation slopes varies depending on the model. For details, refer to “Settings” - “[DISPLAY OPTION] menu” - “[UNIFORMITY]” in the operating instructions of the projector.

⑥ Display on PC
When you put a check in 
, the Gradient Correction settings are applied in the editing area.
Put a check here when you want to see the combined effect of Gradient Correction settings and Flexible Correction settings in the editing area.
When the check is removed from 
, the Gradient Correction settings are not applied to display in the editing area. The settings will still be reflected in the projector, however.

⑦ Lamp Status
When a projector that uses a lamp as light source is selected, this indicates the lamps that are currently lit.
[None] is displayed if none of the lamps is lighted.

⑧ Reset
Return the Gradient Correction and Flexible Correction settings to their default values.

⑨ Switch mode
OFF: Disable the Flexible Correction settings.
ON(Pre): Enable the Flexible Correction settings and process before geometry correction.
ON(Post): Enable the Flexible Correction settings and process after geometry correction.

Note
The selection options may be [OFF] and [ON] depending on the model.

Right-clicking
If other than OFF was selected in Flexible Correction, clicking the right button of the mouse in the editing area displays a menu with following items. The functions of these items are the same as with the Edit submenu items.
☞ “Edit submenu” (page 62)

Reset, Flip Vertical, Flip Horizontal, Area Select, Point Select
Flexible Correction
When correcting partial unevenness in image color, you can set the degree of the change in the gradation color to be applied to the area surrounding the selected target point.
This setting can be made individually for each of the three colors Red, Green, and Blue.
Setting range: 0 to 1023

Interlocked
By putting a check in Interlocked, you can set Flexible Correction to link the value set to all three of colors Red, Green, and Blue.

Store
Reflects the gradation settings in the projector and saves them in the projector.
The settings are maintained even when the main power of the projector has been turned off.

Factory Default
Discard the current Flexible Correction settings and initialize to the factory default state.

Generate from Geometry
Generate the data of Flexible Correction based on the adjustment data of geometry correction.
If you select the adjustment data of geometry correction to reference, a selection screen appears for selecting whether or not to display in combination with the Flexible Correction data currently being adjusted or to discard that data and create new data.

Gamma
Perform inverse gamma correction to remove gamma value influence.
Setting range: 1.0 to 2.8 (in 0.1 steps)
Adjustment may not be possible depending on the model.

Edit
In addition to the menu items described in "Main menu" (page 25), the following menu items can be used on the Uniformity screen. However, these menu items are valid only when the Flexible Correction method is used for correction.

Edit submenu
Reset
Return the Gradient Correction and Flexible Correction settings to their default values.
This item cannot be selected when [Area Select] has been selected.
Neither can it be selected when the target area has not been set.

Flip Vertical
Click to flip vertically the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected.

Area Select
While an area is selected, its control points are displayed.
The target area can be enlarged or reduced or moved using the control points.

Point Select
Confirms settings for the target area currently being set.

Neither [Point Select] cannot be selected concurrently with Area Select.
Flexible Correction Procedure

Select the target point from which gradation is to be applied, and then specify the target area (the range to be corrected) and apply correction. When doing this, specify the points at which grid lines cross as target points.

1. **Select other than OFF in Flexible Correction and enable the Flexible Correction settings.**

2. **Click or drag the mouse to select a target point.**
   
   You can also select multiple target points at the same time.
   
   A red frame is displayed around the perimeter of the area defined by the selected target points, and this becomes the target area (the correction area).
   
   * The target area and target point can be selected using the same method as for the control points of the geometry correction grid.
   
   ➤ "Selecting the control points" (page 44)

3. **Adjust the parameters.**

   Gradation is applied to the selected color in the target area defined by the target points is such a manner that the color is toned down toward the periphery of the area.

4. **Right-click and select [Area Select], and display the operation points (green) in the target area.**

   Using the mouse, drag the operation points to enlarge or reduce the size of the target area.
   
   If the mouse cursor is placed in the target area and then dragged, the target area can be moved.
   
   • [Area Select] can also be selected on the Edit submenu.

   **Note**

   Enlarging or reducing the size of the target area does not change the number of selected target points.

5. **Right-click to select [Point Select], and release the operation point display.**

   • [Point Select] can also be selected on the Edit submenu.

   **Note**

   [Point Select] and [Area Select] can be toggled by pressing the space key.

6. **Repeat the above steps when you want to apply correction to multiple target areas.**

   Where the target areas overlap, correction will be applied by multiplying the respective settings.
Brightness Control

When a single image is configured using a multiple number of projectors, the brightness levels of the images projected from the projectors may not be consistent. If this is the case, adjust the projectors so that the brightness levels are made consistent. The brightness correction can also be done automatically at periodic intervals.

Brightness Control screen

The items displayed will vary depending on the projector you are using.

Brightness Control Gain

This is where the projector brightness is set. The brightness of the image projected from the projectors is set according to the numerical value that is set here.

Operating Mode

This is where the operating mode of the projector is set.
Adjustment and Settings

Brightness Control

High:
This reduces the life of the light source more than Normal, but select this when a higher level of brightness than Normal is required.

Normal:
Select this when a high level of brightness is required.

Eco:
This mode produces a lower brightness than in [Normal] mode, but extends the life of the light source.

Long Life1/Long Life2/Long Life3:
These modes produce a lower brightness than in [Eco] mode, but extend the life of the light source.

User1/User2/User3:
These modes allow you to configure separate [Max Light Output Level] and [Light Output] settings.

Max Light Output Level:
This allows you to adjust the upper limit for brightness correction of the screen based on the change in brightness of the light source.

Light Output:
This allows you to adjust the brightness of the light source.

For details, refer to the operating instructions of the projector.

② Mode
This is where the brightness correction mode is selected.

OFF:
The brightness is not corrected.

Auto:
The brightness levels of the images projected from the projectors are corrected by the brightness sensors of the projectors.
For details, refer to the operating instructions of the projectors concerned.

PC:
The brightness levels of the images projected from the projectors are corrected using the “Multi Monitoring & Control Software”.
For details, refer to the Operating Instructions of “Multi Monitoring & Control Software”.

③ Link
This is where the link mode is set.
The mode is enabled when [Auto] has been selected as the Mode setting.

OFF:
The brightness level of the selected projector is corrected.

Group A/Group B/Group C/Group D:
The brightness levels of the projectors in the respective group are corrected.
The groups are set using the network function of the projectors.
For details, refer to the operating instructions of the projectors.

④ Calibration Message
When a check mark is entered for Calibration Message, a message is displayed while measuring the brightness levels for correcting the brightness.
Some models do not support this function.

⑤ Chroma Correction
When a check mark is entered for Chroma Correction, color is adjusted together with brightness.
Some models do not support this function.
6 Calibration Time
The time at which to start measuring the brightness levels for correcting the brightness is selected here.

The time can be set when a check mark is entered for [Calibration Time]. Some models do not support this function.

7 Apply
Click this to reflect the brightness control setting in the projector.

8 Status
Brightness correction-related errors are displayed here.

<table>
<thead>
<tr>
<th>Status</th>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Brightness sensor error</td>
<td>Something is wrong with the brightness sensor (projector).</td>
</tr>
<tr>
<td></td>
<td>The brightness cannot be measured.</td>
<td>The brightness cannot be corrected due to a factor that is not</td>
</tr>
<tr>
<td></td>
<td>Please check the status of the projector.</td>
<td>related to the brightness sensor.</td>
</tr>
<tr>
<td>Yellow</td>
<td>The brightness can no longer be corrected</td>
<td>The brightness that can be corrected by the projector is</td>
</tr>
<tr>
<td></td>
<td>by a significant margin.</td>
<td>reaching its limit.</td>
</tr>
<tr>
<td>Green</td>
<td>No Error</td>
<td>Normal condition.</td>
</tr>
</tbody>
</table>

9 Update
Click this button to check the projectors and update the Status displays.
**Color Matching**

When configuring a single image using a multiple number of projectors, the coloring of the image projected from the various projectors may not be consistent. If this is the case, adjust the projectors to match the coloring.

**Color Matching screen**

![Color Matching screen diagram]

**Note**

The items that can be adjusted, setting details, and setting range vary depending on the model.

1. **Mode**
   - The color matching mode is selected here.
     
     **OFF**
     - Color matching is not performed.
     
     **3 Colors**
     - The inconsistencies in the colors are corrected by adjusting three colors (Red, Green and Blue).
     
     **7 Colors**
     - The inconsistencies in the colors are corrected by adjusting seven colors (Red, Green, Blue, Cyan, Magenta, Yellow and White).
     
     **709 Mode**
     - The brightness (Y) and chrominance coordinate (x, y) values are adjusted here based on the values obtained using a coloring chromoscope capable of measuring chrominance coordinates and brightness levels.
     
     The Target Data values are fixed.
     
     **Measured**
     - The brightness (Y) and chrominance coordinate (x, y) values are adjusted here based on the values obtained using a coloring chromoscope capable of measuring chrominance coordinates and brightness levels.
     
     The Target Data values can be adjusted.
     
     For details, refer to the Operating Instructions of the projector.
Adjustment and Settings

Color Matching

② 3 Colors
The Red, Green and Blue values are set here.
The settings take effect when [3 Colors] has been selected as the Mode setting.
The White value can be set in addition to the Red, Green and Blue values for some models.

③ 7 Colors
The Red, Green, Blue, Cyan, Magenta, Yellow and White values are set here.
The settings take effect when [7 Colors] has been selected as the Mode setting.

④ Measurement Data
The Black, Red, Green, Blue and White values are set here.
The settings take effect when [709 Mode] or [Measured] has been selected as the Mode setting.

⑤ Target Data
The Red, Green, Blue, Cyan, Magenta, Yellow and White values are set here.
The settings take effect when [Measured] has been selected as the Mode setting.
Two kinds of masking are available.
To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector.
☞ “Activation” (page 12)

**Line Masking**

The shape to be masked is set by moving the operation points on the four sides—top, bottom, left and right—of the projected image.
The area to be masked can also be inverted between positive and negative.

**Bitmap Masking**

The bitmap in the 1-bit monochrome format is loaded and set as the masking data.
The position and size of the masking can be changed.
Bitmaps from 8 x 8 pixels to 1920 x 1200 pixels (when the resolution of the projector is 1920 x 1200 dots or 1400 x 1050 dots) or 3840 x 2400 pixels (when the resolution is other than the aforementioned) are supported.
The *.bmp and *.dib file extensions are supported.
The area to be masked can also be inverted between positive and negative.

**Note**

- The Line Masking and Bitmap Masking settings can be used simultaneously. In that case, masking applies to the each area set in the settings.
- When the input signal of the projector is changed, retransmission to the projector may be required.
Adjustment and Settings

1. **Sub Window**
   Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
   An image of the entire projection area is displayed on Sub Window.
   - Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.

2. **Zoom In**
   Zooms in to the editing area.

3. **Zoom Out**
   Zooms out the editing area.

4. **Red**
   Selects whether the operation points on the left side of the projected image are to be displayed or not displayed.
   - This performs the same operation as [Mask Marker] – [Red] on the View submenu.

5. **Blue**
   Selects whether the operation points at the top of the projected image are to be displayed or not displayed.
   - This performs the same operation as [Mask Marker] – [Blue] on the View submenu.

6. **Green**
   Selects whether the operation points on the right side of the projected image are to be displayed or not displayed.
   - This performs the same operation as [Mask Marker] – [Green] on the View submenu.

7. **Orange**
   Selects whether the operation points at the bottom of the projected image are to be displayed or not displayed.
   - This performs the same operation as [Mask Marker] – [Orange] on the View submenu.

8. **Editing Area**
   Click the operation points to select them, and then drag them to form the shape that is to be masked.

   **Right-clicking**
   Clicking the right-mouse button in the editing area displays a menu with following items. The menu functions are the same as with the Edit submenu.
   ➤ “Edit submenu” (page 71)
   - Reset, Flip Vertical, Flip Horizontal

9. **Mode Switching**
   OFF: Masking is not performed.
   PC-1 / PC-2 / PC-3: Masking is enabled.

   **Note**
   When masking is enabled, only one piece of data (PC) can be saved for some models.
Edit, View

In addition to the menu items described in "Main menu" (page 25), the following menu items can be used on the Masking screen.

<table>
<thead>
<tr>
<th>Edit submenu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset</td>
</tr>
<tr>
<td>When Line Masking has been performed, the positions of the operation points are returned to their initial statuses.</td>
</tr>
<tr>
<td>Returns to the status established when the bitmap has been loaded when Bitmap Masking is executed.</td>
</tr>
</tbody>
</table>

| Edit submenu                  |
| Flip Vertical                |
| Click to flip vertically the correction status of the entire image. |

| Edit submenu                  |
| Flip Horizontal              |
| Click to flip horizontally the correction status of the entire image. |

| View submenu                  |
| Mask Marker (Red, Green, Blue, Orange) |
| Selects whether the operation points are to be displayed or not displayed. |
| The non-displayed operation points are fixed at the positions when the selection was made not to display them. |
Line Masking

① Left
When a check mark is entered for [Left], masking based on the operation point on the left side of the projected image is enabled.

② Upper
When a check mark is entered for [Upper], masking based on the operation point at the top of the projected image is enabled.

③ Right
When a check mark is entered for [Right], masking based on the operation point on the right side of the projected image is enabled.

④ Lower
When a check mark is entered for [Lower], masking based on the operation point at the bottom of the projected image is enabled.

⑤ Invert
When a check mark is entered for [Invert], the Line Masking area can be inverted between positive and negative.

The operation points at both ends of a side can be moved around the outer circumference (along the four sides) of the image.
When an operation point at the center of a side is moved, it can be moved without changing the angle of the straight line that connects the operation points at both ends of the side.
When the operation points have been selected, they can also be moved by operating the cursor keys on the keyboard.
Bitmap Masking

File
Click this button to open the screen on which to select the bitmap data used for masking. Using the bitmap data which has been loaded, mouse operations can be used to move, enlarge or reduce the masking area.

The bitmap data can be moved, enlarged, or reduced in a display area with a resolution of 2880 x 1800 pixels (when the resolution of the projector is 1920 x 1200 dots or 1400 x 1050 dots) or 5760 x 3600 pixels (when the resolution is other than the aforementioned).

If [File] is clicked when the bitmap data for masking has already been loaded, the previously loaded bitmap data is discarded and the new loaded bitmap data is set for masking.

Invert
When a check mark is entered for Invert, the Bitmap Masking area can be inverted between positive and negative.

Bitmap data (example)

Drag to move.

When the center point here is dragged, the masking area can be enlarged or reduced horizontally or vertically.

When a point in one of the four corners is dragged, the masking area can be enlarged or reduced without changing the aspect ratio.
Input Signal Adjustments

Projectors normally identify the input signals automatically, but if unstable signals are to be input, this software application allows the format matching the input signals to be selected, position adjustments to be made, and so on by manual means.

Input Signal screen

1. **Input Select**
   These are used to select the input.
   Click the input (selector) button of the signals to be projected.
   The inputs that can be selected vary depending on the model. For a model equipped with slots, the buttons are enabled only for the slots with boards inserted, and the inputs that can be selected are displayed on the buttons.

2. **Input Select**
   Image showing the Input Select section.

3. **Input Select**
   Image showing the Input Select section.

4. **Input Select**
   Image showing the Input Select section.

5. **Input Select**
   Image showing the Input Select section.

6. **Input Select**
   Image showing the Input Select section.

7. **Input Select**
   Image showing the Input Select section.

8. **Input Select**
   Image showing the Input Select section.

9. **Input Select**
   Image showing the Input Select section.

10. **Input Select**
    Image showing the Input Select section.

This operation is reflected in the projector even if a check mark has not been entered for _Auto Transfer_.

---

Adjustment and Settings

Input Signal Adjustments
## System Selector

The system format which matches the input signals is selected here. The formats which can be selected differ depending on the projector model, input signals and input connectors.

<table>
<thead>
<tr>
<th>Input Select</th>
<th>System Selector</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RGB1, Y/C or RGB1, Y/C, Video</strong></td>
<td>When [RGB/YPbPr] is selected*1</td>
</tr>
<tr>
<td>RGB / VGA60</td>
<td>Auto</td>
</tr>
<tr>
<td>YCbCr / YPbPr / 480p YCbCr</td>
<td>NTSC</td>
</tr>
<tr>
<td>480p RGB</td>
<td>NTSC4.43</td>
</tr>
<tr>
<td>YCbCr / 640x480/60p YCbCr</td>
<td>PAL</td>
</tr>
<tr>
<td>480/60p RGB</td>
<td>PAL-M</td>
</tr>
<tr>
<td></td>
<td>PAL-N</td>
</tr>
<tr>
<td></td>
<td>SECAM</td>
</tr>
<tr>
<td></td>
<td>PAL60</td>
</tr>
</tbody>
</table>

| **RGB2** | When [Y/C] or [Video] is selected*1 |
| RGB / VGA60 | Auto |
| YCbCr / YPbPr / 480p YCbCr | NTSC |
| 480p RGB | NTSC4.43 |
| YCbCr / 640x480/60p YCbCr | PAL |
| 480/60p RGB | PAL-M |
| | PAL-N |
| | SECAM |
| | PAL60 |

| **Video** | **DVI-D** |
| Video | Auto |
| NTSC | RGB |
| NTSC4.43 | YCbCr / YPbPr |
| PAL | |
| PAL-M | |
| PAL-N | |
| SECAM | |
| PAL60 | |

<p>| <strong>HDMI</strong> | <strong>Digital Link</strong> |
| HDMI | Auto |
| RGB | RGB |
| YCbCr / YPbPr | YCbCr / YPbPr |</p>
<table>
<thead>
<tr>
<th>Input Select</th>
<th>System Selector</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDI1 or SDI</td>
<td>SDI2</td>
</tr>
<tr>
<td><strong>When [Single Link] is selected</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
<td><strong>When [Dual Link] is selected</strong>&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td>Auto</td>
<td>Auto</td>
</tr>
<tr>
<td>480i YCbCr</td>
<td>1080/24p RGB</td>
</tr>
<tr>
<td>480i/60i YCbCr</td>
<td>2K/24p RGB</td>
</tr>
<tr>
<td>576i YCbCr</td>
<td>2K/24p XYZ</td>
</tr>
<tr>
<td>576/50i YCbCr</td>
<td>1080/24sF RGB</td>
</tr>
<tr>
<td>720/50p YPbPr</td>
<td>2K/24sF RGB</td>
</tr>
<tr>
<td>720/60p YPbPr</td>
<td>2K/24sF XYZ</td>
</tr>
<tr>
<td>1035/60i YPbPr</td>
<td>1080/25p RGB</td>
</tr>
<tr>
<td>1080/24p YPbPr</td>
<td>1080/30p RGB</td>
</tr>
<tr>
<td>1080/24sF YPbPr</td>
<td>1080/50i RGB</td>
</tr>
<tr>
<td>1080/25p YPbPr</td>
<td>1080/60i RGB</td>
</tr>
<tr>
<td>1080/30p YPbPr</td>
<td>1080/50p YPbPr</td>
</tr>
<tr>
<td>1080/50i YPbPr</td>
<td>1080/60p YPbPr</td>
</tr>
<tr>
<td>1080/60p YPbPr</td>
<td>2K/48p RGB</td>
</tr>
<tr>
<td>1080/24p RGB</td>
<td>2K/50p RGB</td>
</tr>
<tr>
<td>1080/24sF RGB</td>
<td>2K/60p RGB</td>
</tr>
<tr>
<td>1080/25p RGB</td>
<td>2K/48p YPbPr</td>
</tr>
<tr>
<td>1080/30p RGB</td>
<td>2K/50p YPbPr</td>
</tr>
<tr>
<td>1080/50i RGB</td>
<td>2K/60p YPbPr</td>
</tr>
<tr>
<td>1080/60i RGB</td>
<td>2K/60p YPbPr</td>
</tr>
<tr>
<td>2K/24p RGB</td>
<td></td>
</tr>
<tr>
<td>2K/25p RGB</td>
<td></td>
</tr>
<tr>
<td>2K/30p RGB</td>
<td></td>
</tr>
<tr>
<td>2K/48p RGB</td>
<td></td>
</tr>
<tr>
<td>2K/50p RGB</td>
<td></td>
</tr>
<tr>
<td>2K/60p RGB</td>
<td></td>
</tr>
</tbody>
</table>

*1 In the Other screen, select with [Display Option] - [RGB In] - [RGB1 Input Setting].

*2 In the Other screen, select with [Display Option] - [SDI In] - [SDI Link].

<sup>*</sup> “Display Option” (page 81)

**Note**

- For models that do not support dual link HD-SDI signals, the system format that can be selected when [SDI1], [SDI], or [SDI2] is selected with [Input Select] is the same as for [Single Link].
- Even if an [Input Select] button shown in the table above is selected, the function may be disabled depending on the projector you are using.
3 Aspect
The aspect ratio of the images is selected here. The aspect ratios that can be selected are listed below:

- Default / Auto / VID Auto
- Through
- 16:9
- 4:3
- H FIT
- V FIT
- HV FIT

For details, refer to the operating instructions of the projectors.

4 Clock Phase
Image flickering and contour blurring are adjusted here.
Input value range: 0 to 31
However, they cannot be adjusted when Y/C signals have been selected as the input signals.
For details, refer to the operating instructions of the projectors.

5 Zoom Mode
The zoom mode is selected here.
The setting is enabled when [Default / Auto / VID Auto] has been selected as the Aspect setting.
The modes that can be selected are listed below:

- Internal
- Full

For details, refer to the operating instructions of the projectors.

6 Vertical (Zoom)
The zoom magnification in the vertical direction is set here.
Input value range: 50 to 999

7 Horizontal (Zoom)
The zoom magnification in the horizontal direction is set here.
Input value range: 50 to 999

8 Interlocked
When a check mark is entered for  
, the same zoom magnification can be set in both the horizontal and vertical directions.

9 Vertical (Shift)
The vertical position of the projected image is set here.
The input value range varies depending on the projector model.

10 Horizontal (Shift)
The horizontal position of the projected image is set here.
The input value range varies depending on the projector model.

Note
The Input Signal screen items cannot be reset with the [Reset Data (Current Tab)] command on the File submenu and icon menu.
Projector Menu Settings

Some of the operations using the projector’s menus can be performed using this software application.

Other screen

1. Picture
   Click to display the Picture screen.
   The video mode, black level and other settings related to the image adjustments can be selected.

2. Advanced Menu
   Click to display the Advanced Menu screen.
   The blanking width, input resolution and other settings can be selected.

3. Display Option
   Click to display the Display Option screen.
   The color correction, aspect ratio and other settings related to the image display used for large screens can be selected.

4. Projector Setup
   Click to display the Projector Setup screen.
   The projector’s projection system, lamp selection and other hardware settings can be established.

5. The items displayed will vary depending on the projector you are using.
   P in P
   Click to display the P in P screen.
   The positions and sequence of priority for the main screen and sub screens as well as other P in P functions can be set.
   Multi Display
   The inputs for 4-split display, frame lock, and other settings for the multi screen function can be set.
The following items can be set:

<table>
<thead>
<tr>
<th>Picture Mode **</th>
<th>Gamma</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contrast</td>
<td>System Daylight View</td>
</tr>
<tr>
<td>Brightness</td>
<td>Dynamic Iris</td>
</tr>
<tr>
<td>Color</td>
<td>Auto Iris</td>
</tr>
<tr>
<td>Tint</td>
<td>Manual Iris</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Dynamic Gamma</td>
</tr>
<tr>
<td>Noise Reduction</td>
<td>Dynamic Contrast</td>
</tr>
<tr>
<td>Waveform Monitor</td>
<td>Auto Contrast</td>
</tr>
<tr>
<td>Line Position</td>
<td>Bright Signal Level</td>
</tr>
<tr>
<td>Color Temperature</td>
<td>Lights Out Timer</td>
</tr>
<tr>
<td>White Balance Red High</td>
<td>Lights Out Signal Level</td>
</tr>
<tr>
<td>White Balance Green High</td>
<td>Manual Intensity</td>
</tr>
<tr>
<td>White Balance Blue High</td>
<td>Dynamic Gamma</td>
</tr>
<tr>
<td>White Balance Red Low</td>
<td>AI</td>
</tr>
<tr>
<td>White Balance Green Low</td>
<td>White Gain</td>
</tr>
<tr>
<td>White Balance Blue Low</td>
<td>Color Space</td>
</tr>
</tbody>
</table>

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the operating instructions of the projector.

**Note**
- Items marked ** are reflected in the projector even when a check mark has not been entered in Auto Transfer.
- The Picture screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon menu.
**Advanced Menu**

The following items can be set:

<table>
<thead>
<tr>
<th>Digital Cinema Reality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blanking</td>
</tr>
<tr>
<td>Upper</td>
</tr>
<tr>
<td>Left</td>
</tr>
<tr>
<td>Right</td>
</tr>
<tr>
<td>Lower</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Dots</td>
</tr>
<tr>
<td>Display Dots</td>
</tr>
<tr>
<td>Total Lines</td>
</tr>
<tr>
<td>Display Lines</td>
</tr>
</tbody>
</table>

| Clamp Position          |
| Frame Response          |
| Frame Delay             |
| Frame Creation          |
| Frame Creation Mode     |
| Film Detection          |

| Frame Lock              |
| Raster Position         |
| Vertical                |
| Horizontal              |

| Quad Pixel Drive        |

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the operating instructions of the projector.

**Note**
The Advanced Menu screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon menu.
The settings of the items listed below can be established and operated.

<table>
<thead>
<tr>
<th>Large Screen Correction</th>
<th>Color Correction</th>
<th>Digital Link In</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Setting</td>
<td>Red</td>
<td>Digital Link Signal Level</td>
</tr>
<tr>
<td>Screen Format</td>
<td>Green</td>
<td>Digital Link EDID Select</td>
</tr>
<tr>
<td>Vertical Position *</td>
<td>Blue</td>
<td>Digital Link EDID Mode</td>
</tr>
<tr>
<td>Horizontal Position *</td>
<td>Cyan</td>
<td>Digital Link EDID Resolution</td>
</tr>
<tr>
<td>Auto Signal</td>
<td>Magenta</td>
<td>Digital Link EDID V Scan Freq.</td>
</tr>
<tr>
<td>Auto Setup</td>
<td>Yellow</td>
<td>Signal Level</td>
</tr>
<tr>
<td>Mode</td>
<td>Backup Input Setting</td>
<td>EDID Select</td>
</tr>
<tr>
<td>Display Dots *</td>
<td>Backup Input Mode</td>
<td>EDID Mode</td>
</tr>
<tr>
<td>Position Adjust</td>
<td>Automatic Switching</td>
<td>EDID Resolution</td>
</tr>
<tr>
<td>Signal Level Adjust</td>
<td>Simul Input Setting</td>
<td>EDID Resolution/V Scan Freq.</td>
</tr>
<tr>
<td>Execute</td>
<td>RGB1/RGB2</td>
<td>RGB In</td>
</tr>
<tr>
<td>Background Color</td>
<td>HDMI/DVI-D</td>
<td>RGB1 Sync Slice Level</td>
</tr>
<tr>
<td>Startup Logo</td>
<td>SD1/SD2</td>
<td>RGB2 Sync Slice Level</td>
</tr>
<tr>
<td>Cut Off</td>
<td>SDI In</td>
<td>RGB2 EDID Select</td>
</tr>
<tr>
<td>Red</td>
<td>Slot In</td>
<td>RGB2 EDID Mode</td>
</tr>
<tr>
<td>Green</td>
<td>SDI In</td>
<td>RGB2 EDID Resolution</td>
</tr>
<tr>
<td>Blue</td>
<td>SDI Link</td>
<td>RGB2 EDID V Scan Freq.</td>
</tr>
<tr>
<td>Image Rotation</td>
<td>SDI1 Signal Level</td>
<td>DVI-D In</td>
</tr>
<tr>
<td>Closed Caption Setting</td>
<td>SDI1 Bit Depth</td>
<td>DVI EDID</td>
</tr>
<tr>
<td>Shutter Setting</td>
<td>SDI1 3G-SDI Mapping</td>
<td>DVI Signal Level</td>
</tr>
<tr>
<td>Mechanical Shutter</td>
<td>SDI2 Signal Level</td>
<td>DVI EDID Select</td>
</tr>
<tr>
<td>Fade-In</td>
<td>SDI2 Bit Depth</td>
<td>DVI EDID Mode</td>
</tr>
<tr>
<td>Fade-Out</td>
<td>SDI2 3G-SDI Mapping</td>
<td>DVI EDID Resolution</td>
</tr>
<tr>
<td>Startup</td>
<td>Dual Link Signal Level</td>
<td>DVI EDID V Scan Freq.</td>
</tr>
<tr>
<td>Shut-Off</td>
<td>Dual Link Bit Depth</td>
<td>HDMI In</td>
</tr>
<tr>
<td>On-Screen Display</td>
<td>Dual Link 3G-SDI Mapping</td>
<td>HDMI Signal Level</td>
</tr>
<tr>
<td>OSD Position</td>
<td>Target Input</td>
<td>HDMI EDID Select</td>
</tr>
<tr>
<td>OSD Size</td>
<td>(The selection options of the</td>
<td>HDMI EDID Mode</td>
</tr>
<tr>
<td>OSD Rotation</td>
<td>following adjustment items</td>
<td>HDMI EDID Resolution</td>
</tr>
<tr>
<td>OSD Design</td>
<td>vary depending on the selected</td>
<td>HDMI EDID V Scan Freq.</td>
</tr>
<tr>
<td>OSD Memory</td>
<td>setting.)</td>
<td>Slot In</td>
</tr>
<tr>
<td>Input Guide</td>
<td>Resolution</td>
<td>Link Select **</td>
</tr>
<tr>
<td>Warning Message</td>
<td>4K Division</td>
<td>Link Setting ***</td>
</tr>
<tr>
<td></td>
<td>3G-SDI Mapping</td>
<td>EDID Setting ***</td>
</tr>
<tr>
<td></td>
<td>System Selector</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Color Space</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sampling</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bit Depth</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Signal Level</td>
<td></td>
</tr>
</tbody>
</table>

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the operating instructions of the projector.

**Note**

- Items marked with an asterisk (*) cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon menu.
- Items marked ** are switched automatically depending on whether a board is inserted in the slot and the type of board if a board is inserted.
- Items marked *** are switched automatically depending on setting of Link Select.
Projector Setup

The settings of the items listed below can be established and operated.

**Projection Method**  
**Cooling Condition**  
**High Altitude Mode**  
**Lamp Select** *  
**Lamp Relay**  
**Time**  
**Standby Mode**  
**Quick Startup**  
**Valid Period**  
**No Signal Shut-Off**  
**No Signal Lights-Off**  
**Initial Startup**  
**Startup Input Select**  
**AC Voltage Monitor**  
**Date and Time**  
**Time Zone** *  
**Synchronize to PC** **  
(The projector's clock setting is synchronized with the computer.)

**Multi Projector Sync**  
**Mode**  
**Contrast Sync**  
**Shutter Sync**

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the operating instructions of the projector.

**Note**

- Items marked with an asterisk (*) cannot be reset using the [New All Data] and [New Data (For Current Window)] commands on the File submenu and icon menu.
- Items marked ** are reflected in the projector even when a check mark has not been entered in Auto Transfer.
### P in P

The following items can be set:

<table>
<thead>
<tr>
<th>P in P Mode **</th>
<th>Sub Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame Lock</td>
<td>Input Signal</td>
</tr>
<tr>
<td>Type</td>
<td>Size</td>
</tr>
<tr>
<td>Main Window</td>
<td>Interlocked</td>
</tr>
<tr>
<td>Input Signal</td>
<td>Vertical</td>
</tr>
<tr>
<td>Size</td>
<td>Horizontal</td>
</tr>
<tr>
<td>Interlocked</td>
<td>Position</td>
</tr>
<tr>
<td>Vertical</td>
<td>Vertical</td>
</tr>
<tr>
<td>Horizontal</td>
<td>Horizontal</td>
</tr>
<tr>
<td>Horizontal</td>
<td>Clock Phase</td>
</tr>
</tbody>
</table>

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the operating instructions of the projector.

**Note**

- Items marked ** are reflected in the projector even when a check mark has not been entered in Auto Transfer.
- The P in P screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon menu.
### Multi Display

The following items can be set:

- **Multi Display Mode**
- **Frame Lock**
- **Upper Left Window**
- **Lower Left Window**
- **Upper Right Window**
- **Lower Right Window**

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the operating instructions of the projector.

**Note**

- Items marked ** are reflected in the projector even when a check mark has not been entered in `Auto Transfer`.
- The Multi Display screen items cannot be reset with the [Reset Data (Current Tab)] command on the File submenu and icon menu.
Projector Control

Control commands can be sent to the projector.

Command Control screen

1. **Projector list**
   Displays a list of the numbers, projector names, IP addresses, and model numbers of the connected projectors. The selected projector is the target for sending the command. The control command send target can be switched by selecting a projector in the list.

   **Note**
   - Multiple projectors can be selected by holding down the Ctrl key while clicking.

2. **Command input**
   Enter the control command to send.

3. **Send command**
   Send the entered control command to the selected projector.

4. **Edit registered commands**
   Up to 15 frequently used commands can be registered. Clicking opens the Edit screen. Only a button with a command registered can be clicked.
   The text to display on the button can also be edited in the Edit screen. If the text to display on the button is not edited, the default text ("Function*" where * is the number of the button) is displayed.

5. **Send registered commands**
   Sends the registered commands to the selected projector.

6. **Command Log**
   Displays the communication log for sent commands. This displays four information items: send time, send destination projector name, sent command, and response to sent command.
   Each information item can be sorted in ascending and descending order. The maximum number of logs that can be displayed is 2,048.

7. **Clear command log**
   Clear the information displayed in the command log.
⑧ Close
Close this screen. The command log is also cleared when the screen is closed.

**Edit screen**

1. **Title**
Enter the text to display on the registered command send buttons in the Command Control screen. The text can consist of a maximum of 32 characters including letters, numbers, and symbols. When there is no input in Command, the text entered here will not be reflected in the Command Control screen.

2. **Command**
Enter the control commands to register.

3. **Clear**
Clear both the registered command name and registered command.

4. **Confirm**
Confirm the current editing information.

5. **Cancel**
Discard the current editing information. A screen appears to confirm whether or not discarding the information is a problem.
Auto Screen Adjustment

Applying the ET-CUK10/CK10P Auto Screen Adjustment upgrade kit to the projector expands the functions of “Geometry Manager Pro”, and allows automatic adjustment of geometry correction, edge blending, color and brightness correction, adjustment of white balance, and adjustment of black level according to the shape of the screen through use of an externally connected camera.

After performing Auto Screen Adjustment, you can perform further detailed adjustment and correction manually.

**Note**
- The Auto Screen Adjustment upgrade kit is required to enable the Auto Screen Adjustment function.

<table>
<thead>
<tr>
<th>Product Number</th>
<th>Product Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ET-CUK10</td>
<td>Auto Screen Adjustment</td>
<td>Activating on each projector enables the “Auto Screen Adjustment plug-in software” functions.</td>
</tr>
<tr>
<td></td>
<td>Upgrade Kit</td>
<td></td>
</tr>
<tr>
<td>ET-CUK10P</td>
<td>Auto Screen Adjustment</td>
<td>Activating on a computer on which the software is installed enables the “Auto Screen Adjustment plug-in software” functions.</td>
</tr>
<tr>
<td></td>
<td>Upgrade Kit (PC)</td>
<td></td>
</tr>
</tbody>
</table>

**Note**
- You can check whether the “Auto Screen Adjustment plug-in software” is installed and the activation status of the Auto Screen Adjustment upgrade kit (PC) in [About Geometry...] of the Version submenu.
- To use the Auto Screen Adjustment function, prepare a camera separately.

**Preparing Auto Screen Adjustment**

- **Projector connection**
  Use a LAN cable to connect the projector to the computer.

- **Camera connection**
  Use a USB cable to connect the camera to the computer.
  For details on compatible cameras, check the information found on the software download page after logging in to PASS on the Panasonic website (https://panasonic.net/cns/projector/pass/).

- **Connection example**
**Note**

- Positioning the camera so that it faces the screen directly and performing adjustments will obtain more optimal adjustment results. Adjustment is possible when the camera is facing the screen at an angle but may fail if the angle is too large.
- In cases such as the following, adjustment is possible using multiple cameras (up to 6).
  - When the projector layout configuration has 5 or more projectors in the vertical or horizontal direction.
  - When the entire screen does not fit in the capture range of 1 camera.
    However, black level adjustment is only possible using 1 camera.

**Compatible screens for Auto Screen Adjustment**

Auto Screen Adjustment may not be performed properly depending on the shape of the screen. If adjustment is not performed properly, perform adjustments manually.

<table>
<thead>
<tr>
<th>Compatible screens</th>
<th>Non-compatible screens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flat</td>
<td>Folded</td>
</tr>
<tr>
<td>Curved screen</td>
<td></td>
</tr>
<tr>
<td>Curved in one direction</td>
<td>Folded screen type</td>
</tr>
<tr>
<td>Curved in two directions</td>
<td></td>
</tr>
<tr>
<td>Curve changes smoothly</td>
<td>* Individual adjustments for each side are possible.</td>
</tr>
<tr>
<td>S-curve</td>
<td>Variable curve type</td>
</tr>
<tr>
<td>360-degree curved screen</td>
<td></td>
</tr>
</tbody>
</table>
Settings for Auto Screen Adjustment are configured in a wizard format.

1. **Adjustment items selection**
   - **Projector Layout**
     - Projector layout settings
     - Projector selection and positioning
   - **Camera Setting**
     - Camera connection and layout
     - Camera settings
   - **Projection Setting**
     - Geometry
     - Edge Blending
     - Color Matching
     - White Balance
     - Black Level

**Auto Screen Adjustment complete**
Auto Screen Adjustment procedure

Starting Auto Screen Adjustment and selecting the adjustment item

1. Click the [AUTO ADJUST] button in the main screen.

2. Click the items you want to adjust.

Adjustment items selection screen

- You can select from following five options
  - [Geometry, Edge Blending, Color Matching]
  - [Geometry, Edge Blending]
  - [Color Matching]
  - [White Balance]
  - [Black Level]

By clicking the [Re-adjust] button to the right of each option, you can restore it to the setting that it had previously.

* “Readjust by recalling previous settings” (page 92)

- The subsequent steps and screens that appear in the procedure will vary depending on the selected items.

Note

- Make sure the projector is turned on before starting Auto Screen Adjustment. Proper correction will not be possible if the projector is in the standby state.
- When performing automatic screen color, brightness, white balance, and black level correction, do so in an environment where the impact from external lighting will be low.
- While setting Auto Screen Adjustment, a progress indicator will appear at the top right of each screen, allowing you to check which step you are currently performing.
Readjust by recalling previous settings

By clicking the [Re-adjust] button, you can restore options to the settings that they had previously.

Note
- If an option does not have a previous setting, the [Re-adjust] button for that option is disabled.
- If readjustment fails, Auto Screen Adjustment is canceled. In this case, you can continue making adjustments using the usual manual procedure from the point at which adjustment was interrupted.
- To cancel Auto Screen Adjustment in progress, click [Abort]. In this case, you can continue making adjustments manually from the point at which adjustment was interrupted.
Projector Layout

1 Specify the projector configuration in the projector layout setting screen.

1) When you click the [Restore] button and layout information from previously configured projectors exists, the layout information is loaded and applied to the layout information display area.

2) Enter the height, width, and stack layout for the projectors in the [Height / Width / Stack] fields.
   - Up to 99 projectors can be configured.
   - In the case of 1 camera, adjustment can be performed for up to 4 vertically, up to 4 horizontally, and up to 6 stacked.
   - 5 or more projectors can be configured either vertically or horizontally by using multiple cameras. In such cases, the relationship between the number of projectors and the number of cameras is as follows.

<table>
<thead>
<tr>
<th>Number of projectors</th>
<th>1 to 4</th>
<th>3 to 7</th>
<th>4 to 10</th>
<th>5 to 13</th>
<th>6 to 16</th>
<th>7 to 19</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of cameras</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
</tbody>
</table>

   - 360-degree curved screens require 5 or more projectors in the vertical or horizontal direction and 3 or more cameras.

<table>
<thead>
<tr>
<th>Number of projectors</th>
<th>5 to 9</th>
<th>5 to 12</th>
<th>5 to 15</th>
<th>6 to 18</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of cameras</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
</tr>
</tbody>
</table>

Note

• You cannot configure a layout that includes more projectors than the total number of connected projectors.
• If [Geometry, Edge Blending, Color Matching], [Color Matching], [White Balance], or [Black Level] was selected in the adjustment items selection screen, configure the layout so that either height (vertical) or width (horizontal) is more than one projector.

3) Click [Next].
   - To return to the previous screen, click [Back].
2 Select the projectors for which to perform correction in the projector selection screen.

1) Select the check boxes of the projectors for which you want to perform correction in the connected projectors list.
   - You can select all the projectors by clicking the [Select All] button, or clear selection of all the projectors by clicking the [Clear All] button.
   - If you clicked the [Restore] button in step 1 to load previous layout information, the check boxes for the configured projectors will be selected.

   Note
   - If * is displayed on the left of a projector name, you cannot select that projector for auto screen adjustment.
   - Apply the Auto Screen Adjustment upgrade kit (ET-CUK10) to the projectors or apply the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P) to the computer.
     "Activation" (page 12)

2) Click [Next].
   - To return to the previous screen, click [Back].
   - When [Color Matching] and [White Balance] are selected, a warning message will appear if projectors of different models coexist. Click [Next] to continue the process, or click [Cancel] to reselect projectors.
   - An error message will appear in the following cases.
     In such cases, click [OK] and select the projectors again.
     - Projectors with different resolutions coexist when [Geometry, Edge Blending, Color Matching], [Geometry, Edge Blending] or [Black Level] is selected.
     - The number of selected projectors does not match the number of projectors configured in the projector layout setting screen in step 1.
     - When the Auto Screen Adjustment upgrade kit (ET-CUK10/ET-CUK10P) is not applied to either the selected projectors or computer.

   Note
   When you click [Next], the geometry correction, edge blending, color/brightness correction, and white balance adjustment of the projectors will be initialized.
3 Confirm projector positioning in the projector positioning screen.

1) Click the layout window to position the projectors.
   - Configure the projectors in order, starting with the first projector in the list of selected projectors. Each number will be projected on the screen. Position the projectors in the layout window so that their numbers match the projected numbers.
   - Click the [Identify] button to verify the actual projector positions on the projection screen. Each projector will project their numbers on the screen when you click the [Identify] button.
   - You can cancel the positioning of the projector currently being configured by clicking the [Undo] button, or cancel positioning for all projectors by clicking the [Reset] button.

2) Click [Next].
   - To save the projector positioning information, click [Next].
   - To return to the previous screen, click [Back].
   - An error message will appear if positioning of all the projectors is not complete. Configure settings again.
   - If other than [Black Level] is selected, go to the camera connection screen.
     "Camera Setting" (page 96)

4 Select the storage location of the current geometry correction data in the geometry correction data storage location confirmation screen.

1) The current geometry correction data needs to be stored inside the projector so select that storage location from [PC-1] to [PC-3]. If the data is already stored, select [No need to store].
   - The storage location is common for all projectors that are target for Auto Screen Adjustment.
   - If the current geometry correction data is not stored, that data will be discarded during the process. The result of black level adjustment will not be able to be guaranteed.
2) Click [Next].

- When [Next] is clicked, the current geometry correction data is saved to the storage location.
- To return to the previous screen, click [Back].

### Camera Setting

1) Verify camera connection in the camera connection screen.

    ![Camera connection screen]

    - Click the [Search Camera] button.
      - The model names of the detected cameras are listed.
      - If a camera is not displayed in the list, check the following.
        - The camera is properly connected
        - The camera is turned on
      - Verify that the check boxes of the cameras to be used are selected.
      - You can select all the cameras by clicking the [Select All] button, or clear selection of all the cameras by clicking the [Clear All] button.

2) Click [Next].

    - To return to the previous screen, click [Back].

    - If [Geometry, Edge Blending, Color Matching] or [Geometry, Edge Blending] is selected and the layout is configured so that either height (vertical) or width (horizontal) is more than one projector in the projector layout screen, the black level adjustment selection screen opens.

    ![Black level adjustment selection screen]

    Select the process for the black level of the area to be overlapped.
    - [Set temporary value]: Overwrite the black level value with the temporary value of the corresponding models.
    - [Use current settings]: Retain the current (pre-adjustment) black level value.
    - [Adjust using the camera]: Adjust the black level using the camera.
Auto Screen Adjustment  Auto Screen Adjustment procedure

- When there are 2 or more cameras, goes to "2 Camera layout screen."
- When there is one camera, goes to "3 Camera setting screen."

**Note**
- If there are two or more cameras, [Adjust using the camera] cannot be selected.
  Click [Next].
- If [Black Level] is selected, an error occurs when two or more cameras are selected.

2 Decide the layout (arrangement) of the cameras while checking the captured images in the camera layout screen.
Perform this work when using 2 or more cameras.

![](image)

1) Set the camera layout.
   - [Horizontal / Vertical]: Camera placement direction (horizontal/vertical)
   - [360 degree screen]: Select this check box when 360-degree screen
2) Select the cameras and set the target ranges.
   - The target range of the selected camera is indicated by an orange frame in the camera layout window.
3) Capture a test shot with the camera.
   - When you click the [Test Shot] button, a test shot is captured with the selected camera and the captured image appears in the captured image display window.
   - Verify that the target range fits within the captured image.
     If it does not fit, check the actual position of the camera, the selection status of the camera, and the target range setting.
4) Click [Next].

**Note**
- The layout settings of the camera may not be able to be changed depending on the conditions.
- One projector's worth of overlap is required for images captured with cameras that are side by side.
3 Configure the camera you will use in the camera setting screen.

1) Click the [Auto Setup] button.
   - A test pattern appears on the screen, and camera configuration starts automatically.
   - When using 2 or more cameras, configure the settings of all the cameras.
   - The setting values configured in step 1) appear in the [White Balance / Shutter Speed / ISO / F-number] fields.
     You can select the [Manual Setup] check box to configure the setting values manually.
   - If [Black Level] is selected, next also set the camera for black level adjustment.

2) Capture a test shot.
   - A test shot is captured when you click the [Test Shot] button, and the captured image appears in the image display window. Verify that the entire screen fits within the image display window.

   **Note**
   - To obtain the optimal adjustment results, make adjustments so that the target area of the screen fills as much of the captured image display window as possible.
   - Adjustment may fail if the target area of the screen does not fit properly within the captured image display window.
   - An error message appears if camera configuration fails. In such cases, check the content of the message, click [OK], and configure settings again.
   - If the screen is too bright or there is a strong light present, overexposure may occur and adjustment may fail.

3) Click [Next].
   - To return to the previous screen, click [Back].
Projection Setting

Adjust the option selected in “Starting Auto Screen Adjustment and selecting the adjustment item” (page 91). Perform the operations by referring to their explanations on the following pages.

- When [Geometry, Edge Blending, Color Matching] or [Geometry, Edge Blending] is selected
  - “Geometry and Edge Blending Adjustments” (page 99)
- When “Color Matching” is selected
  - “Color Matching Adjustments” (page 105)
- When “White Balance” is selected
  - “White Balance Adjustments” (page 108)
- When “Black Level” is selected
  - “Black Level Adjustments” (page 111)

Geometry and Edge Blending Adjustments

1. When the following confirmation screen appears, check the content displayed and click [Next].

   When you click [Next], the projector settings will change to those displayed on this screen.
   - To return to the previous screen, click [Back].
2 Configure the screen type and overlap areas in the screen setting screen.

1) Specify the screen type and number of cursors.
   - Select the screen type that matches the shape of the screen. If [Horizontal Curve], [Vertical Curve] or [H-V Curve] is selected, specify the number of cursors according to the curvature of the screen.
     - [4 Corner]: Flat screen
     - [Horizontal Curve]: Screen that is curved in the horizontal direction
     - [Vertical Curve]: Screen that is curved in the vertical direction
     - [H-V Curve]: Screen that is curved in the horizontal or vertical direction
   - When [Cylindrical-H] or [Cylindrical-V] is selected, you can specify 3 to 100 cursors for each side.
   - When [H-V Curve] is selected, you can specify at 3 or more cursors per side, for a total of up to 300 cursors.

2) While viewing the actual screen, position the cursors in the screen setting window according to the shape of the screen.
   - Position each cursor by dragging them or by using the arrow keys on the keyboard. When using the keyboard, pressing an arrow key while a cursor is selected moves the cursor 8 dots, pressing an arrow key while holding the Ctrl key moves the cursor 1 dot, and pressing an arrow key while holding the Alt key moves the cursor 64 dots.
   - You can select the next cursor by pressing the Tab key, or the previous cursor by pressing the Tab key while holding the Shift key.
   - You can also select cursors using the number keys on the keyboard.
   - If cursor layouts were previously configured, you can restore up to the three most recent cursor layout configurations using the [Restore] button. Select [the last], [the second last], or [the third last] from the pull-down menu to select the configuration you want to restore, and click the [Restore] button.
   - To return all cursors to their original positions, click [Reset].
   - When the screen type is [Horizontal Curve], [Vertical Curve], or [H-V Curve], the maximum number of cursors that are actually projected on the screen at one time is 100. Up to two digits can be displayed for numbers on the screen, and the 100th, 200th, and 300th cursors will be displayed as "0." For example, when you want to select the 101st cursor, press the Tab key while the 100th cursor is selected, or enter "101" using the keyboards number keys. The cursors that are projected are switched in groups of 100 in different colors. Cursors 1 to 100 are displayed in yellow, 101 to 200 in orange, and 201 to 300 in magenta.

3) To configure the horizontal and vertical overlap areas, enter the values in the [Edge Blending Width] fields.
   - You can also use the sliders to specify values.
   - A percentage value that corresponds to the configured pixel count appears in the percent display.
   - To configure the overlap areas automatically, place check marks next to [Auto] of [Horizontal] and [Vertical]. The values resulting from automatic configuration appear in a message after adjustment is complete.
3 If the content being projected has margins and you want to set the margin area, select the check box next to [Enable] by [Margin Setting] in the check screen setting screen.

**Note**

- Setting a screen margin makes it easier to set the position of cursors when making screen settings.
- Setting of straight margins is possible. Setting of curved margins is not possible.

The margin setting screen opens.

Select the type for margin with [Margin Type] and then set the margin size as a numeric value.

- **Margin type**
  - Select the margin type.
  - **[Horizontal]**: Horizontal margins at the top and bottom of the image
  - **[Vertical]**: Vertical margins at the left and right sides of the image
  - **[Custom]**: Margins other than the above

- **Auto Masking**
  - **[OFF]**: Auto Masking is not performed.
  - **[PC-1 / PC-2 / PC-3]**: Auto Masking is enabled.

**Note**

- To use Auto Masking together with margins, configure [Auto Masking].
  - **[Auto Masking]** will only be applied if the upgrade kit (ET-UK20) has been applied to the selected projector.
  - “Activation” (page 12)
Auto Screen Adjustment procedure

- Specify margins on each side individually. Select either [%] or [pixel] for [Scale] and enter the overall size of the projected content (including margins) in terms of the percentage or number of pixels. Note that the total margin that can be set on any given side cannot exceed 60%.

If [pixel] is selected for [Scale], change the numerical value for [Total resolution] according to the overall content size.

- Click the [Restore] button to restore the margins to the last previously set configuration.
- Click the [Reset] button to return the configured margin size to the initial value (about 5%).
- Click the [Open] button to read reference image files (files with the extension .bmp or .jpeg).

- When done setting the margins, click [OK].
  Display returns to the screen setting screen.
4 Click [Start].

To save the projector positioning information, click [Start].
- A progress bar appears, and Auto Screen Adjustment for geometry correction and edge blending starts.
- To return to the previous screen, click [Back].

To cancel Auto Screen Adjustment, click [Abort].
In such cases, click [OK] when the following screen appears.

5 When Auto Screen Adjustment is successfully completed, the following message appears.

To save the adjustments in the projector, select [PC-1], [PC-2], or [PC-3] as the storage location, or select [None] if you do not want to save the settings, and then click [OK]. If you click [Cancel] the adjustments are not saved in the projector.

If [Geometry, Edge Blending] was selected in “Starting Auto Screen Adjustment and selecting the adjustment item” (page 91) and [Set temporary value] or [Use current settings] was selected in the black level adjustment screen (page 96), Auto Screen Adjustment is complete.
If [Geometry, Edge Blending, Color Matching] was selected in “Starting Auto Screen Adjustment and selecting the adjustment item” (page 91) and [Set temporary value] or [Use current settings] was selected in the black level adjustment screen (page 96), go to the procedure of “■ Color Matching Adjustments” (page 105).
In the case of other than the above, go to the procedure of “■ Black Level Adjustments” (page 111).
Auto Screen Adjustment

- A message appears if Auto Screen Adjustment fails. In such cases, check the content of the message, click [OK], and configure settings again.
- To return to the screen from step 2 (page 100), click [OK].

- Capture a test shot, and verify that the entire screen fits within the image display window. (page 98)
- Verify that a large portion of the projected image to be adjusted fits within the screen.
- Check that the camera and screen are as close as possible to directly facing each other.

Note

- When you click the push button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment appears.
- To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

- The projector layout and cursor layout information configured during Auto Screen Adjustment is stored until the next time you configure the settings.
- To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of "Geometry Manager Pro".
  - "Adjustment and Settings - Geometry Correction" (page 41)
  - "Adjustment and Settings - Edge Blending" (page 55)
Auto Screen Adjustment  Auto Screen Adjustment procedure

■ Color Matching Adjustments

1  When the following confirmation screen appears, check the content displayed and click [Start].
   When you click [Start], the projector settings will change to those displayed on this screen.
   ● To return to the previous screen, click [Back].

   Setting initialization confirmation screen (color and brightness adjustment)

   ● A progress bar appears, and Auto Screen Adjustment for color and brightness adjustment starts.

   ● To cancel Auto Screen Adjustment, click [Abort].
   In such cases, click [OK] when the following screen appears.
Auto Screen Adjustment

2 A message indicating that Auto Screen Adjustment is complete appears.
To exit Auto Screen Adjustment, click [OK].
- To restore the conditions from before adjustment, click [Before Adjustment]. If you click [After Adjustment] after clicking [Before Adjustment], the displays are returned to the conditions from after Auto Screen Adjustment completion.

The following message appears if Auto Screen Adjustment could not be completed and must be performed again.
To perform Auto Screen Adjustment for color and brightness correction again, click [Continue]. To exit Auto Screen Adjustment, click [Finish].

① Colors for which Auto Screen Adjustment was not completed are displayed here.
② Here you can confirm the adjustment results for the selected color on screen.

A message appears if Auto Screen Adjustment fails due to overexposure.
If the screen is too bright or there is a strong light present, overexposure may occur. In such cases, click [OK] and configure settings again.
- If Auto Screen Adjustment for color and brightness adjustment is performed again and fails to complete, a message will appear. Click [OK] to exit Auto Screen Adjustment.
  In such cases, perform adjustment manually in the main screen of “Geometry Manager Pro”.
  "Adjustment and Settings – Color Matching" (page 67)
Auto Screen Adjustment

Auto Screen Adjustment procedure

Note

- When you click the button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment appears. To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

- The projector layout and cursor layout information configured during Auto Screen Adjustment is stored until the next time you configure the settings.

- To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of "Geometry Manager Pro".
  - "Adjustment and Settings – Brightness Control" (page 64)
  - "Adjustment and Settings – Color Matching" (page 67)
White Balance Adjustments

1. When the following confirmation screen appears, check the content displayed and click [Next].

   When you click [Next], the projector settings will change to those displayed on this screen.
   • To return to the previous screen, click [Back].

   ![Setting initialization confirmation screen](image)

   Setting initialization confirmation screen
   (White Balance Adjustments)

   1) When adjusting color, use the [Auto] option to optimize adjustment for the screen overall, or the [Target Setting] option when configuring a target (standard) projector.
2) If you select the [Target Setting] option, also select the projector that is to be the target.
   - When you click the target projector number, the number and its frame change to red.
   - Click the [Restore] button to restore the last previously set configuration.
   - Click the [Identify] button to verify the actual projector positions on the projection screen. Each projector will project their numbers on the screen when you click the [Identify] button.

   ![Auto Screen Adjustment screen]

   **Note**
   - White balance is adjusted by configuring the [Picture]-[Color Temperature]-[USER1]-[White Balance High] values.
   - In order to manually pre-configure white balance for the target projector, change the [White Balance High] settings as described earlier.
   - The results of white balance adjustment are saved to the projector for each input signal. When the input signal is changed, do the adjustment again.
   - With some projectors that use single-chip DLP, the color matching setting is forcibly set to OFF when white balance is adjusted. Refer to the operating instructions of the projector.

2) Click [Start].

   The projector positioning information is saved.

   A progress bar appears, and Auto Screen Adjustment for white balance starts.

   ![Progress bar]

   • To cancel Auto Screen Adjustment, click [Abort].

   Click [OK] when the following screen appears.
3 A message indicating that Auto Screen Adjustment is complete appears.
To exit Auto Screen Adjustment, click [OK].
- To restore the conditions from before adjustment, click [Before Adjustment]. If you click [After Adjustment] after clicking [Before Adjustment], the displays are returned to the conditions from after Auto Screen Adjustment completion.

- The following message appears if Auto Screen Adjustment could not be completed and must be performed again. To perform Auto Screen Adjustment for white balance again, click [Continue]. To exit Auto Screen Adjustment, click [Finish].

① Here you can confirm the adjustment results for the selected color on screen.

- A message appears if Auto Screen Adjustment fails due to overexposure.
  If the screen is too bright or there is a strong light present, overexposure may occur. In such cases, click [OK] and configure settings again.
- If Auto Screen Adjustment of white balance is not completed a second time, a message is displayed. Click [OK] to complete Auto Screen Adjustment.
  In this case, perform adjustments manually in the main screen of “Geometry Manager Pro”.
  “Adjustment and Settings - Picture” (page 79)

Note
- When you click the button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment appears.
  To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

- To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of “Geometry Manager Pro”.
  “Adjustment and Settings - Input Signal Adjustments” (page 74)
■ Black Level Adjustments

1 When the following confirmation screen appears, check the content displayed and click [Start].

When you click [Start], the projector settings will change to those displayed on this screen.

- To return to the previous screen, click [Back].

   A progress bar appears, and Auto Screen Adjustment for black level adjustment starts.

- To cancel Auto Screen Adjustment, click [Abort].

   Click [OK] when the following screen appears.

2 A message indicating that Auto Screen Adjustment is complete appears.

   Click [OK].

   If [Geometry, Edge Blending] or [Black Level] was selected in “Starting Auto Screen Adjustment and selecting the adjustment item” (page 91), Auto Screen Adjustment is complete.

   If [Geometry, Edge Blending, Color Matching] was selected at “Starting Auto Screen Adjustment and selecting the adjustment item” (page 91), go on to the procedure for “■ Color Matching Adjustments” (page 105)
To restore the conditions from before adjustment, click [Before Adjustment]. If you click [After Adjustment] after clicking [Before Adjustment], the displays are returned to the conditions from after Auto Screen Adjustment completion.

The following message appears if Auto Screen Adjustment could not be completed and must be performed again. To perform Auto Screen Adjustment for black level correction again, click [Continue]. To exit Auto Screen Adjustment for black level correction, click [Finish].

A message appears if Auto Screen Adjustment fails due to the impact of external lighting, etc. An error occurs if the surroundings are too bright or the brightness is changed. In such cases, click [OK] and configure settings again.

If Auto Screen Adjustment for black level correction is performed again and fails to complete, a message will appear. Click [OK] to exit Auto Screen Adjustment for black level correction. In this case, perform adjustments manually in the main screen of “Geometry Manager Pro”.

“Adjustment and Settings - Edge Blending” (page 55)

Note

When you click the × button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment appears. To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

The projector layout information configured during Auto Screen Adjustment is stored until the next time you configure the settings.

To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of “Geometry Manager Pro”.

“Adjustment and Settings - Edge Blending” (page 55)
Frequently Asked Questions

Check the following points once more before requesting repair.

<table>
<thead>
<tr>
<th>Projector is not recognized.</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Has the projector’s power been turned on?</td>
</tr>
<tr>
<td>● Is the projector supported by the software application? ☞ “Projectors supported” (page 10)</td>
</tr>
<tr>
<td>● Have the units been connected properly? ☞ “Preparation” (page 10)</td>
</tr>
<tr>
<td>● Has the projector’s network been set up correctly? ☞ “Setting the Projector” (page 11)</td>
</tr>
<tr>
<td>● Has an attempt been made to connect 100 or more projectors?</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No connection can be made between my projector and my computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>● When Windows Firewall has been detected</td>
</tr>
</tbody>
</table>

**Windows 7**

Is this software registered in [Start] → [Control Panel] → [System and Security] → [Windows Firewall] → [Allowed programs and features] tab?

To register the software, perform the following.

* How to set up
  1. Click [Start] → [Control Panel].
  2. When the <Control Panel> appears, click [System and Security] → [Allow a program through Windows Firewall].
  3. When <Allow programs to communicate through Windows Firewall> appears, click [Change settings] → [Allow another program...].
  4. When the <Add a Program> dialog box appears, select [Geometry Manager Pro] and click [Add].
     If [Geometry Manager Pro] is not on the list, click [Browse], select [GeometryGUI.exe] and click [Open]. [Geometry Manager Pro] appears in the [Program] column
  6. Select the network from [Home/Work (Private)], [Public] you want to allow connection to and click to select the check box.
  7. Click [OK] in the <Allow programs to communicate through Windows Firewall>.
  8. This software will now be added to the Windows firewall’s exception list.

**Windows 8.1 / Windows 10**

Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel] → [System and Security] → [Windows Firewall] → [Allow an app or feature through Windows Firewall] to see if this program is on the list. Add the software to [Allow an app or feature through Windows Firewall].

* Adding procedure
  1. Press [X] while holding down the [Windows logo] key on the keyboard and click [Control Panel].
  2. When the <Control Panel> appears, click [System and Security] → [Allow an app through Windows Firewall].
  3. When <Allow apps to communicate through Windows Firewall> appears, click [Change settings] → [Allow another app...].
  4. When the <Add an app> dialog box appears, select [Geometry Manager Pro] and click [Add].
     If [Geometry Manager Pro] is not on the list, click [Browse...], select [GeometryGUI.exe] and click [Open]. [Geometry Manager Pro] appears in the [App] column
  6. Select the [Private] or [Public] network you want to allow connection to and click to select the check box.
  7. Click [OK] in the <Allow apps to communicate through Windows Firewall>.
  8. This software will now be added to the Windows firewall’s exception list.

**<When another firewall has been detected>**

Are any firewall-containing applications installed?

If any applications which contain firewalls are installed, the installation may not complete.
(The firewall function may activate without launch of the application if the application has already been installed.)

If this occurs, firewall settings must be changed in order to allow connection to the network.

See the User’s Manuals for all applications containing firewalls to perform these settings.
### Messages that appear when an attempt to uninstall or update the software is made

<Is the "Warning 1910. Could not remove ..." message displayed?>

If an NVIDIA driver is installed on the computer, the following message may appear.

![Warning 1910. Could not remove Geometry Manager Pro. Verify that the shortcut file exists and that you can access it.](image)

Click [OK] to continue an uninstall or update procedure.

Although uninstalling the software will also remove the desktop shortcut icons, they will be regenerated when you start up the computer next time. Manually delete the shortcut icons.

### Files cannot be saved.

- Has an attempt been made to save a file that includes values that exceed the range which can be set in the projector?
- Is there enough free memory on the hard disk?
- Do you have the authority to access the folder in which the file is to be saved?

### Image correction cannot be performed.

- Have settings been sent to the projector that exceed the range which can be set in the projector?
- Has the projector's power been turned on?
  - Some items cannot be set if the projector's power is not on.
- Are the projector's input connectors set correctly, and have the correct signals been input?
  - Some items cannot be set depending on the input connector settings, the types of signals input and whether or not signals are present.

### The bitmap used for masking purposes cannot be loaded.

- Has an attempt been made to load bitmap data which is not in the 1-bit monochrome format?
- Does the bitmap have the appropriate size?
  - Bitmaps smaller than 8 x 8 pixels and bitmaps larger than 1920 x 1200 pixels (when the resolution of the projector is 1920 x 1200 dots or 1400 x 1050 dots) or 3840 x 2400 pixels (when the resolution is other than the aforementioned) cannot be used for masking.

### Cannot connect to the camera (Auto Screen Adjustment).

- Is the camera turned on?
- Is the camera connected to the computer properly?
- Is there a large number of data files stored on the SD card inserted in the camera?
  - If camera connection fails, try removing the SD card and performing the camera connection settings again.

### Auto Screen Adjustment does not start.

- You may not be able to execute Auto Screen Adjustment depending on the projector's settings. For details on operations restricted by the projector's settings, check the information found on the software download page after logging in to PASS on the Panasonic website (https://panasonic.net/cns/projector/pass/).

### The image does not fit exactly on flat screens (Auto Screen Adjustment).

- The projected image may not match the edges of the screen exactly if the screen is sagging.
  - If the top and bottom edges are off:
    - In the screen setting screen, set the screen type to [Horizontal Curve], and specify at least 3 cursors according to the shape of the screen.
  - If the left and right edges are off:
    - In the screen setting screen, set the screen type to [Vertical Curve], and specify at least 3 cursors according to the shape of the screen.
### Geometry correction results in an images that appears curved (Auto Screen Adjustment).

- This occurs on soft curved screens and on screens with heavy sag.
  
  Correction is performed so that the image appears straight from the point of view of the camera.
  
  Position to the camera so that it is as close as possible to directly facing the screen.

### An exposure adjustment error occurs on the camera (Auto Screen Adjustment).

- If the projector is too bright or the screen's gain is high, for example, an exposure adjustment error may occur during camera settings configuration.
  
  In such cases, attach an ND filter to the camera lens, or lower the brightness of the projector before performing adjustment again.
Trademarks

- Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.
- Other company names, product names or other names noted in this manual are trademarks or registered trademarks of the respective companies. Note that ® and TM marks are not indicated in the text of this manual.

Note

- Unauthorized use or reproduction of part or all of this software and manuals is strictly prohibited.
- Panasonic cannot be held liable for any effects resulting from the use of this software and manuals.
- Panasonic reserves the right to revise this software specifications and manual contents without notice.

Panasonic Corporation

Web Site : https://panasonic.net/cns/projector/
© Panasonic Corporation 2017